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Preface

This textbook, Information and Computer Studies for Secondary Schools 
Student’s Book Form Four, is written specifically for form four students in the 
United Republic of Tanzania. It is written in accordance with the 2005 Information 
and Computer Studies Syllabus for Secondary Schools, Form I-IV issued by 
the then Ministry of Education and Culture. The book consists of five chapters, 
which are: Presentation, Using presentation software, Using desktop publishing 
software, Multimedia, and Interactive content. In addition to textual descriptions, 
each chapter contains illustrations, activities, and exercises. You are encouraged 
to do all activities and exercises in this book, and other assignments provided by 
your teacher. This will enable you to develop the intended competencies.

Tanzania Institute of Education
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Chapter

Presentation

01

Introduction
Individuals whose regular jobs require conveying messages to different 
audiences face challenges in communicating their ideas. For example, they 
must think about where to start and end, what to include and not include in 
their communication, or what will be the response of their audiences. In this 
chapter, you will learn about the concept of presentation, qualities of a good 
presentation, qualities of a good presenter, and how to prepare and deliver 
a presentation. The competencies developed will enable you to plan, design 
and present any idea or message in a manner that engages and enriches 
your audience. 

The concept of presentation 
Presentation refers to a means of communication that can be used in various 
contexts such as speaking in front of a group of people, addressing a meeting, 
or briefing a team. During presentation, the presenter conveys a message to 
the audience and in most cases, persuades them to pay attention to the topic  
being presented. The following are examples of contexts in which you will 
need to find the best way of explaining and convincing the audience through a 
good presentation: introducing a new idea, product, service, or piece of work; 
disseminating or sharing knowledge and skills about something; and giving 
instructions to an audience. 

Therefore, presenting is an act of addressing an audience to share ideas or 
information. It is a general term that can also refer to other forms of dialogue such 
as making a speech at a wedding, getting a point across in a video conference, 
or simply expressing yourself to others. Common areas where presentation skills 
are applicable include schools and workplaces. You are likely to use presentation 
skills when demonstrating a class assignment to your teacher, addressing a 
religious gathering, and in addressing entrepreneurship meetings and business 
forums.
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Art and skills of presentation
Presention is said to be both an art and a science. Therefore, as a science, there are 
principles that you need to observe to deliver a good presentation. Also, as an art, 
there are principles you need to follow as part of a presentation. Good presenters 
use their presentation skills to convey a message to an audience. They look smart; 
use presentation tools; use gestures such as eye contact, facial expression, and 
posture; stay in a position that is easily noticeable by the audience; and uses 
moderate voice tone and volume. Qualities of a good presenter are described 
next. 

Appearance: While presenting, make sure that you look smart and dress 
according to the nature of the presentation. For example, if you are giving an 
official presentation, make sure that you dress formally.

Eye contact: While presenting, make sure you maintain eye contact with 
your audience as much as possible. This will help you to regulate the flow of 
communication and control the senses of your audience. Maintaining eye contact 
enables a presenter to easily communicate with the audience and allows a 
presenter to convey interest, concern, warmth, and credibility to the audience.

Facial expressions: A facial expression such as smiling is a powerful act that 
shows happiness, friendliness, warmth, and liking. Smiling is often catching and 
can cause others to react favourably. A smiling presenter makes the audience 
more comfortable during the presentation, which help the audience to concentrate 
on what is being presented.

Posture: The way you position yourself while giving a presentation matters a lot. 
You should not stand still; you should rather talk and move. Standing straight and 
leaning forward communicates that you are approachable, receptive, and friendly. 

Proximity: Proximity to an audience enables the presenter to make better eye 
contact and increases the opportunities for the audience to speak. If possible, 
avoid congested rooms.

Voice projection and tone:	 You should make sure that your voice is heard 
clearly. That means you should project your voice in a manner that the audience 
can hear you well. In doing so, your voice should also be moderate (not too high, 
and not too low). Speaking in a monotone voice should generally be avoided. 

Preparing presentations
When preparing a presentation, you should consider the context of your 
presentation, your personality as a presenter, the characteristics of your audience, 
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the message you want to convey to the audience, the method of delivery, and 
possible impediments. 

Context: You should ask yourself about when and where the presentation will be 
delivered. Familiarize yourself with the settings related to the presentation and 
ask yourself whether the settings are formal or informal, the size of the audience, 
whether it is a small group or a crowd, and the expectations of the audience.  
Asking yourself these questions will enable you to put your presentation in 
context.
Presenter: Your role is to communicate with the audience and influence how 
the presentation goes. Therefore, you should get prepared technically, socially, 
morally, and emotionally. 

Audience: You should try as much as you can to understand your audience: their 
level of understanding, their experience, knowledge, and their values. It is also 
important to know their expectations from your presentation. 

Message: A message is the information you intend to pass on to your audience. 
It should be convincing, expressed in a simple language, and relevant to your 
audience. 

Method of delivery: This refers to how the presentation is delivered. It can be 
face-to-face, from a distance over the TV, radio or over the Internet using video 
conferencing systems such as Zoom. You should observe all the necessary setup 
requirements for the delivery mode of your choice. 

Impediments: These are factors which may hinder the effectiveness of the 
presentation. A presentation can be affected by factors such as power blackouts, 
noise, and weather conditions. Therefore, you should plan how you will deal with 
impediments if they occur. The following precautions may help to mitigate some 
impediments.

1.	 You may need a standby generator if there is a possibility of power outage. 
Likewise, if you are planning to present electronically, you may prepare  
handouts beside your presentation. 

2.	 Prefer an auditorium (presentation hall) that is likely free from noise.

Steps in preparing and giving a presentation
A good presentation typically involves four steps: planning, creating the 
presentation, practising, and presenting.
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Planning: A good presentation requires planning of what is going to be presented. 
A presentation is not about how much the presenter can present, but how much 
the audience can understand. It is important to organize the information into three 
to five points in a slide, because most audiences can easily recall only three to 
five points. 

Creating a presentation: At this point, you prepare materials to be presented 
and organise them for presentation before the audience. If your presentation is 
non-electronic, you must have your visual aids ready, whereas if you are using 
electronic means, you should prepare your slides using a presentation software. 

Practising: At this point, you figure out words and expressions to use during 
the presentation and work out the timing of different sections and an overall 
presentation flow. In addition to these aspects, you should record the presentation 
and review it for improvement. Likewise, consider using different coloured 
highlighters to remind yourself when to pause or emphasize a particular point. 
Also, practice in front of peers and get feedback on how you are presenting. 
Recall that the more you practice, the more comfortable and confident you will 
become with the materials during the actual presentation. 

Presenting: As a presenter, you should make the audience feel comfortable 
and engaged with the presentation. Among other things, you should maintain 
eye contact; not read your slides word to word, only look at them briefly; be 
enthusiastic about the topic; and maintain a welcoming facial expression. 
Also, use repetition. Listening is much different from reading. In reading, the 
audience can usually go back and read about something they have missed or did 
not understand. However, in listening, it is not always possible to go back and 
read what has been missed or not understood. Use repetition through internal 
summaries, transitions, analogies, and stories.

Parts of a  presentation
A good presentation is organised in three parts: introduction, body, and conclusion. 

Introduction: In most cases, an audience pay more attention to a topic which they 
perceive to be important. Therefore, after introducing yourself, before starting 
the presentation, provide a brief outline of the major points you will cover in your 
presentation, relate the topic to the audience, and explain why it is important for 
them to learn about the topic.

Body: This is the core part of your presentation. To make your presentation 
effective, you need to explain the key points by giving clear explanations and 
providing enough examples. Also, use slide movements between sections of the 
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presentation as well as between points in a particular section.  To ensure clarity, it 
is important to maintain a good flow of your presentation content. 

Conclusion: When you approach the end of your presentation, you need to give a 
signal to your audience using transitions such as ‘I am now approaching the end 
of my presentation’, or ‘As a final point, I would like to…’. In the conclusion part, 
you summarize your main points, and tell your audience about the next course 
of action, if needed. Finish by thanking the audience for listening, and welcome 
questions/comments from them.

Exercise 	 1.1

1.	 What do you understand by the term presentation?

2.	 Why are presentations important?

3.	 Describe parts of a good presentation. 

4.	 Why do you think it is important to understand the qualities of a good 
presenter? 

Presentation delivery modes 
Presentation delivery mode refers to the method by which the content is conveyed 
from a sender to a recipient. In this context, presentation delivery mode is the way 
the presenter uses media to convey his/her message to an audience. There are two 
main presentation delivery modes: non-electronic mode and electronic mode.

Non-electronic presentation delivery mode
A non-electronic presentation delivery mode uses non-electronic aid materials 
such as large printed charts, whiteboards, flipcharts, pointers, handouts, cards, 
photos, books, podiums, posters, blackboards, chalks, marker pens, sketchbooks, 
and drawing sheets. This mode is also called traditional mode. In this presentation 
mode, physical objects such as various apparatuses, finished products and 
models of physical objects like the globe (earth) can be used. In non-electronic 
delivery mode, a presentation is given without using any electronic devices such 
as computers, projector, or speaker. This kind of delivery mode is common in 
schools, colleges, and in political rallies. Figure 1.1 shows a person giving a 
presentation using a non-electronic delivery mode.
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Figure 1.1: A person giving a presentation using non-electronic mode of delivery

Generally, non–electronic presentations are more engaging to both the presenter 
and the audience, because the presenter performs different physical activities 
such as writing on a flipchart or demonstrating ideas using presentation aids or 
equipment/tools that keep them engaged. 

Aids for non-electronic presentations 
Aids are tools which are used to plan, create and give presentations. They also 
help to emphasise various parts of the presentation and make it easy for the 
audience to understand. As mentioned before, presentation aids include charts, 
whiteboards, flipcharts, pointers, handouts, cards, photos, books, and podiums. 
These aids are described next. 

Charts: These help the audience to follow the presentation and serve as a 
reference for the presenter. However, to be effective, charts need sufficient light, 
and images/drawings must be clear and large enough. Figure 1.2 shows examples 
of charts. 
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Figure 1.2: Examples of large printed charts

Boards: These are useful when the presenter wants to write something during the 
presentation. When using them, make sure that you use a handwriting that is large 
enough and clear for the audience to read. Also, use the boards for brief notes and 
illustrations. These boards should be used as aids, not the overall focus of your 
presentation. Figure 1.3 shows an example of a whiteboard. 

Figure 1.3: A whiteboard
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Flipcharts: These consist of a collection of large paper sheets that are usually 
fixed using a flipchart stand. Flipcharts can be easily moved from one venue to 
another. Sometimes, illustrations such as charts can be presented on a flipchart. 
On a flipchart, information can be written in sections and displayed only when 
necessary. As such, it helps both the presenter and audience to pause between 
sections when flipping the papers. During your presentation, you need to have 
a flipchart stand (see Figure 1.4) to fix your papers. When preparing yourself, 
practice flipping your chart to ensure smooth flipping of papers during the 
presentation. Also, position your flipchart suitably relative to your height and 
make sure there is enough space for you to stand and move freely.   

Figure 1.4: Examples of flipcharts and flipchart stands

Pointers: Another tool that can be used for non-electronic presentations is a 
pointer. A pointer helps a presenter stay a bit far from the content being presented. 
It also assists the presenter to draw the attention of the audience to what is pointed 
to. To properly use a pointer, the following points should be considered: use a 
pointer only when it is needed; do not hold it unnecessarily; make sure that the 
pointer does not hide the content; and use it when elaborating details which need 
special attention such as specific parts of a map or diagram. Pointers used in 
non-electronic presentations are physical objects like a stick. Figure 1.5 shows a 
presenter holding a stick pointer.
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Figure 1.5: A presenter holding and using a pointer during presentation in a classroom

Handouts: Handouts carry additional information that help the audience to follow 
the presentation. For example, the presenter may distribute details of statistical 
data pertaining to the presentation. Handouts should be prepared early and placed 
in the presentation room. In addition, handouts should be given to the audience 
only when they are needed for effective delivery of presentation materials. 

Books: You can also use books as tools for non-electronic presentations. These are 
used as either sources of additional information or quick references to supplement 
your presentation. Note that you will normally not be able to read a larger portion 
of a book, but you can just refer to a figure, page, or table. Therefore, to use a 
book in your presentations, consider the following points: the pages that you 
will use during your presentation should be marked beforehand, when showing 
a page, you should avoid obstructing the audience, you should move around to 
make sure that everyone sees what you intended to convey.

Podiums: Podiums are small platforms used by presenters when giving a 
presentation. Having the right podium will help you to communicate with your 
audience more effectively. When setting and using a podium, consider the 
following points: make sure you put it in a place that is clearly visible to the 
entire audience; make sure that the podium is proportional to your height; do 
not rest your hands or lean on the podium; and you may put few materials on the 
podium for your quick reference. Figure 1.6 shows examples of podiums. 

ICS FORM 4 COM FINAL .indd   9 13/03/2022   14:12



10

ICS

Figure 1.6: Examples of podiums

Advantages of non-electronic presentations
Based on its nature and scope, a non-electronic presentation has several 
advantages, including the following: 

1.	 It does not need specialised skills to prepare it. 

2.	 It can be used even where there is no electricity. 

3.	 It is easier to draw the attention of the audience towards the presenter and 
to a theme being presented. 

4.	 It can increase the engagement of participants, especially when 
presentation aids are employed.

5.	 It is easy for the audience to take notes from the presenter, because the 
aids used are generally static.

Disadvantages of non-electronic presentations 
Because a non-electronic presentation does not use electronic devices/aids, the 
whole task of ensuring that the presentation is effective rests on the shoulders of 
a presenter. As such, this type of presentation is associated with the following 
disadvantages: 

1.	 It is challenging to ensure smooth flow of information, and that could 
make it difficult for the audience to understand what is being presented. 

ICS FORM 4 COM FINAL .indd   10 13/03/2022   14:12



11

ICS

2.	 It can require someone with a good handwriting for writing text related to 
the content of a presentation. 

Activity 1.1: Preparation of aids for a non-electronic presentation

Use different materials found in your environment to prepare five aids for a non-
electronic presentation of your choice.  

Electronic presentation delivery mode 
An electronic presentation delivery mode involves the use of electronic devices 
such as computers with a presentation software, multimedia projectors and, 
sometimes, pointers.  Depending on the context and purpose of the presentation, 
other devices such as radio receivers, TV sets, smartphones, and computers 
connected to the Internet can also be used during a presentation. Thus, an 
electronic presentation delivery mode may also refer to a media through which a 
presentation is delivered. 

When preparing an electronic presentation, you should start by organizing your 
thoughts and key points. Next, you should plan how your presentation will 
appear to the audience; that is, you should decide on the use and place of text 
and visual aids such as charts and figures. Finally, use a presentation software 
such as Microsoft Office PowerPoint or Apache OpenOffice Impress to prepare 
your presentation. Figure 1.7 shows an example of an electronic presentation in 
a meeting.

Figure 1.7: An example of an electronic presentation during a meeting
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Aids for electronic presentations 
Electronic presentations make use of different aids that help in the planning, 
preparation, and delivery of presentations. These aids include specialized 
computer software, multimedia projectors, speakers, and microphones. 

Microphones: Microphones are devices that work with other devices such as 
speakers to ensure that your voice can be heard properly during the presentation. 
The choice of a microphone for your presentation will depend on the nature 
of your presentation. For example, if you are going to move around, you can 
consider using a wireless microphone. Thus, choose a microphone that suits the 
need of your presentation. Also, make sure that you test the microphone before 
your presentation starts. Figure 1.8 shows examples of microphones that can be 
used in a presentation. 

Figure 1.8: Examples of microphones 

Multimedia Projectors: These are devices that are used to project a computer 
display onto a magnified view on a screen or wall. They can be connected to 
either a laptop or a desktop computer. In addition, due to advancement of mobile 
technologies, some portable multimedia projectors might be connected to mobile 
devices such as smartphones. These projectors are rechargeable and can be used 
without being connected to a source of power, thus providing the possibility to 
use a device for a while, even in places without access to power. If you plan 
to use a multimedia projector, ensure that you make proper settings and test 
your connections before your audience enters the presentation room. This will 
help you to know in advance if the projector and the computer are compatible 
and are properly working. The projector can be placed on a flat surface such 

ICS FORM 4 COM FINAL .indd   12 13/03/2022   14:12



13

ICS

as on a table or can be mounted on a ceiling. Figure 1.9 shows examples of a 
multimedia projector, while Figure 1.10 shows an example of a rechargeable 
portable multimedia projector.

Figure 1.9(a): A multimedia projector 
placed on a table

Figure 1.9(b): A multimedia projector 
mounted on a ceiling

Figure 1.10: A rechargeable multimedia projector connected to a smartphone 

Software: A software can be used to prepare visual aids, presentation notes, 
and deliver a presentation. In the preparation stage, some software can be used 
to create various visual aids to be used during the presentation. An example of 
software that can be used in the preparation stage of a presentation is image 
editing software such as Adobe Photoshop or Adobe Illustrator. There are other  
many software that can be used in preparing and giving presentations. Popular 
examples of presentation software are Microsoft Office PowerPoint and Apache 
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OpenOffice Impress. Microsoft PowerPoint is a proprietary software, which 
means you need to buy a licence to use it.  Apache OpenOffice Impress is an 
open-source software that can be downloaded and used for free.

Pointers:  Electronic presentations can also use electronic pointers,  also known 
as laser pointers. These pointers require batteries to operate and can be used 
to control presentation slides from a distance. Electronic pointers use wireless 
technology to help the presenter point to a specific area of interest on a slide. They 
can connect wirelessly to your laptop or other electronic devices, and can control 
the flipping of slides. Figure 1.11 shows examples of electronic pointers that are 
used in electronic presentations. 

Figure 1.11: Examples of electronic laser pointers used for presentation

Speaker: Due to poor voice projection, the voice of a presenter may not be heard 
properly by the audience. A speaker can be used to make the voice of a presenter 
audible. The presenter can use a microphone to transfer the sound to an amplifier 
system in this case,  it is a speaker. The speaker receives the sound from the system 
and amplifies it for the audience to hear. Figure 1.12 shows examples of speakers. 

Figure 1.12: Examples of speakers that can be used during presentation
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NOTE: �There are some devices, aids, materials and equipment  that can be used in 
both non-electronic and electronic presentations. For example, a speaker 
can be used to aid a non-electronic presentation in case the presenter 
wants to increase his/her voice.  Others include flipchart and pointers. 

Advantages of electronic presentations
The advantages of electronic presentations can be summarized using five terms: 
engagement, collaboration, flexibility, sharing, and understandability.   

1.	  �Engagement: A presentation software allows a presenter to use different 
media such as animations, high-definition images, and videos in a 
presentation. These media enable conveying ideas easily, engage the 
audience, and minimize boredom to the audience.  

2.	   �Collaboration: A group of presenters can easily collaborate during the 
preparation of a presentation. This is achieved by sharing a presentation 
through cloud storage media such as Google Drive, One Drive, and 
Dropbox. For example, a group of people in different locations can interact 
in real-time and collaborate to improve or deliver a presentation. 

3.	  �Flexibility: You can use multiple templates and customize them to suit 
your needs. It is also easy to correct mistakes or do updates at any stage of 
a presentation, compared to handwritten presentations. 

4.	 Sharing: The presentation materials can easily be shared via email 
programs such as Gmail, social media applications such as WhatsApp, and 
cloud storage such as Google Drive. 

5.	  �Understandability: Tools used in electronic presentation allow the 
combination of various media such as text, video, animations, tables, 
graphs, or pictures in a presentation. Thus, it becomes easier for the 
audience to understand the content of the presentation. For example, 3D 
images or illustrations of how the heart works are not easily presented in 
a non-electronic presentation but can easily be presented in an electronic 
presentation. 

Disadvantages of electronic presentations 
Since electronic presentations involve the use of electronic devices to prepare 
and make presentations, you need to possess some skills on using such electronic 
devices and associated software. Thus, because of their nature, electronic 
presentations have the following disadvantages:
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1.	 They need a presenter to have relevant skills to prepare and make a 
presentation. For instance, you may need skills of using presentation 
software such as Microsoft PowerPoint or Apache OpenOffice Impress and 
publication software such as Microsoft Publisher or Adobe Photoshop. 

2.	 Improper use of visual aids (multimedia) can distract the audience as they 
may concentrate on looking at the visual aids supporting the presentation 
rather than focusing on the content. Also, if a visual aid is not properly 
designed, it can lead to a breakdown in communication between the 
presenter and the audience. 

3.	 It can be difficult for the audience to take notes during the presentation 
as they are supposed to both listen to the presenter and watch the running 
slides. 

Activity 1.2: Investigating and presenting a crosscutting issue of public concern

(i)	 Choose one of the following cross-cutting issues: gender bias, HIV/
AIDS, COVID-19, ICT, road safety, drugs and drug abuse, terrorism, and 
child abuse.

(ii)	 With the help of the Internet or other resources, read about the cross-
cutting issue you have chosen in (i). 

(iii)	 Summarize what you have read. 

(iv)	 Present your summary to your fellow students (your summary should 
have an introduction, body, and conclusion). 

(v)	 Mention aids, materials, equipment or tools that will enable you to prepare 
and deliver your presentation electronically. 

Exercise 1.2 
Review questions 

A. True and False questions 
Write T for a true statement and F for a false statement 

1.	 It is not the duty of a presenter to do everything possible to make the 
audience  understand the message ___

2.	 Presentation skills are important to any public speaker, including teachers, 
students, and politicians ___
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3.	 During a non-electronic presentation, a whiteboard is used to present 
everything that a presenter intends to present to the audience ___

4.	 Non-electronic presentations are difficult to prepare as they need specialised 
skills and availability of power ___

5.	 A microphone is a device used to amplify sound during an electronic 
presentation ___

6.	 A speaker is the only device used in electronic presentation mode ___

B. Multiple choice questions 

Choose the most correct answer and write it in the provided box.

1.	 The following are common visual aids used to enhance non-electronic 
presentations except:
(a)	 Charts 
(b)	 Whiteboards 
(c)	 Projectors 

(d)	 Flipcharts 

2.	 A small platform where a presenter stands when making a presentation is 
known as:
(a)	 Podium
(b)	 Stage
(c)	 Stand 
(d)	 Altar

3.	 A device that is used to display a presentation from a computer to a big 
screen is known as:
(a)	 A microphone 
(b)	 A projector 
(c)	 A speaker 
(d)	 A podium 

4.	 The following are the advantages of an electronic presentation except:
(a)	 Engagement 
(b)	 Monotonicity 
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(c)	 Collaboration 
(d)	 Flexibility 

5.	 One of the following is not a part of a presentation.
(a)	 Practicing 
(b)	 Introduction 
(c)	 Main body 
(d)	 Conclusion 

C: Short answer questions
Answer the following questions 

1.	 Describe aids that can be used in non-electronic presentations.

2.	 Describe aids that can be used in electronic presentations. 

3.	 Is it necessary to use every kind of aid in every presentation? Why?

4.	 Mention and describe common aids of non-electronic presentations that 
can also be used in electronic presentations.

5.	 Appearance is one of the things to consider when preparing for a 
presentation. Explain the meaning of this statement.

6.	 Why do you need to practice before your presentation?

7.	 Describe two software packages that you may use in planning, preparation, 
and delivery of a presentation.

8.	 Use examples to describe the difference between electronic and non-
electronic presentations.  

9.	 Describe situations in which you would use non-electronic presentations 
over electronic presentations. 

10.	 Consider the following scenarios: formal meeting, group discussion, 
lecture session, family gathering, sharing research findings, and a political 
rally. Which mode of presentation would be the most effective means of 
delivering a message to the audience of each of these scenarios? Justify 
your answer. 
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Chapter

Using presentation software

02

Introduction
In Chapter one, you learnt about the concept of presentation, qualities of a 
good presentation, qualities of a good presenter, how to prepare a presentation, 
and presentation delivery modes. In this chapter, you will learn how to use a 
presentation software to prepare, deliver, share, and print your presentation. 
The competence developed will enable you to prepare, deliver, share, and 
print electronic presentations. 

Presentation software 

A presentation software is an application software used for creating, delivering, 
sharing, and printing of electronic presentations. A presentation created using 
a presentation software consists of units called slides. Like a page in a word 
processing software, a slide is a frame used to hold the contents of your presentation, 
which can include text and graphics. A series of slides, arranged according to the 
logical flow of your presentation, form an electronic presentation. Each slide in 
a presentation may contain different combinations of texts and graphics. When 
delivering a presentation, a multimedia projector or any other projection media, 
can be used to display slides to the audience.

Several presentation software exist. They include Microsoft (MS) PowerPoint, 
Apache OpenOffice Impress, Google Slides, Slidebean, Keynote, SlideDog, 
Prezi, Canva, and ClearSlide. MS PowerPoint is among popular presentation 
software. Millions of people in the world use MS PowerPoint for preparing 
and delivering presentations. There are several versions of MS PowerPoint.  
Among them are MS PowerPoint 2007, MS PowerPoint 2010, MS PowerPoint 
2013, MS PowerPoint 2016, MS PowerPoint 2019, and MS PowerPoint 365 
(cloud based). As of this writing, the latest version was MS PowerPoint 2019. 
However, MS PowerPoint 2019 was relatively new, and the predecessor version, 
MS PowerPoint 2016, was still in widespread use. For this reason, this chapter 
gives a detailed discussion on how to use MS PowerPoint 2016 for creating and 
delivering presentations.
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Features of a presentation software 
All presentation software have some common features, including the following. 

Templates: A presentation software comes with a wide range of pre-designed 
slides called templates. These templates are designed to suit various presentation 
scenarios, and if used, save user’s time and effort. When using a presentation 
template, you are required to enter the content of your presentation in it. While 
some templates are built in a presentation software, other templates can be 
downloaded or purchased through Internet.

Slide layouts: The arrangement, design, or outline of items in a slide is known as 
slide layout.  In a presentation, each slide can have a different layout. One slide 
might have a bullet to the left of an image, another slide might have a main title 
and bullets underneath, while another slide might have a chart. 

Master slide: A master slide is a slide from which other slides derive their style 
and layout. A master slide enables you to configure common features that you 
want to appear on each slide. The features you can configure include footer, slide 
number, date, header, and the presenter’s name. You can also use a master slide 
to choose a text style to apply throughout your presentation.

Animation: An animation is a movement or an effect assigned to elements such 
as texts and pictures in a slide to move the content in unique ways during slide 
start, emphasis, and exit. Most presentation software come with a variety of 
features that can be used to add extra flair to your presentations. 

Transition effects: These influence what you see when you move from one slide 
to another. For example, the current slide may appear to dissolve as the next 
slide is displayed. Presentation software consist of numerous slide transitions 
that can be used when switching between slides. Activity 2.1 explore features of 
a presentation software. 

Activity 2.1:  Exploring features of a presentation software 

Use the Internet or any other resource to view and learn about different features 
of a presentation software of your choice.

Working with MS PowerPoint 2016
MS PowerPoint 2016 is a popular presentation software that allows a user to 
create presentation slides that can be viewed on a computer screen, TV, or through 
a projector connected to a computer. MS PowerPoint 2016 is simple to learn and 
use. 
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Launching MS PowerPoint 2016 
There are several ways to launch MS PowerPoint 2016 presentation program, 
depending on the type and version of the operating system installed on your 
computer. For example, suppose you are using Windows 10, you can use the 
Start button on the Windows taskbar and scroll to find a thumbnail icon for MS 
PowerPoint 2016.  Also, you can double click on a PowerPoint shortcut icon that 
may appear on the desktop or MS PowerPoint button on the taskbar. Activity 2.2. 
shows the steps of launching MS PowerPoint 2016 on a computer with Windows 
10 operating system. 

Activity 2.2: Launching MS PowerPoint 2016 

(i)	 Click on the Start button (number 1 in Figure 2.1) to display the start 
menu.

(ii)	 Click on the PowerPoint 2016 thumbnail button (number 2 in Figure 2.1) 
to display a blank screen of MS PowerPoint 2016. 

Figure 2.1: Launching MS PowerPoint 2016 in a computer with Windows 10 
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NOTE: MS PowerPoint 2016 will open a backstage view that shows different 
built-in presentation templates, as shown in Figure 2.2. You can also 
access the recently opened file. 

Figure 2.2: MS PowerPoint 2016 backstage view showing different presentation templates

(iii)	 Click on Blank Presentation to start a new presentation. 

Parts of MS PowerPoint 2016 
MS PowerPoint 2016 has several parts. Some of them are similar to those found 
in other MS Office application software such as MS Word and MS Excel. These 
include (referring to Figure 2.3) Title bar (2), Menu bar (3), Working area (5), 
and Status bar (10). Figure 2.3 shows some main parts of MS PowerPoint 2016. 

Figure 2.3: Some parts of MS PowerPoint 2016
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Key: 
1 = Quick access commands	 2 = Title bar 	 3 = Menu bar

4= Slide pane 	 5 = Working area 	 6 = Main title pane 

7 = Subtitle pane 	 8 = Ribbon of commands 	9 = Slide zoom 

10 = Status bar 

Title bar
The title bar displays the program name and the name of the current document 
you are working with. Also, it contains buttons for minimising, maximising, and 
closing MS PowerPoint 2016 window, as shown in Figure 2.4. 

Figure 2.4: MS PowerPoint 2016 title bar

By default, when creating a new presentation, the title bar will display the 
following text: “Presentation1 - PowerPoint”. After saving your presentation and 
giving it a name, the title bar will display that name, instead of the default one. 
For example, if you name your presentation “Understanding COVID-19”, the 
new title bar will display “Understanding COVID-19 - PowerPoint”. The title 
bar also contains a quick access toolbar. The quick access toolbar allows you to 
access frequently used commands, regardless of the selected tab. Common quick 
access commands include Save, Undo, and Redo. However, one can customise 
the list of quick access commands by removing or adding other commands to 
the quick access toolbar. Activity 2.3 demonstrates how to customise the quick 
access toolbar. 

Activity 2.3: Customising the quick access toolbar 

(i)	 Click on the drop-down arrow to the right of the quick access bar.

(ii)	 On the pop up menu that appears (see Figure 2.5), click on the command 
that you want to add or remove to/from the quick access toolbar. An icon 
for the selected command will appear on (or will be removed from) the 
quick access bar.
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Figure 2.5: Customising the quick access toolbar

Menu bar
MS PowerPoint 2016 menu bar contains a list of different tabs. Some of the tabs 
are File, Home, Insert, Design, Transitions, Animations, Slide Show, Review, 
View, Recording, Add-ins, and Help as shown in Figure 2.6. 

Figure 2.6: MS PowerPoint 2016 menu bar

Each tab has a ribbon that displays a list of commands in groups. For example, 
a ribbon in the Design tab contains a list of command groups such as Themes, 
Variants, and Customize (see Figure 2.10). 

Exploring different tabs on MS PowerPoint 2016 menu bar 
 MS PowerPoint 2016 menu bar contains various tabs such as File tab, Home tab, 
Insert tab, Design tab, Transitions tab, Animations tab, Slide Show tab, Review 
tab, and View tab. This section explores these tabs and the commands contained 
in a ribbon of each tab.
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File tab
MS PowerPoint 2016 File tab appears at the top left corner of the window, just 
below the quick access toolbar. When opened, it displays a backstage view 
containing various submenu items, including Info, New, Open, Save, Save As, 
Print, Share, Export, Close, Account, and Options, as shown in Figure 2.7.  

Figure 2.7: Backstage view of the MS PowerPoint 2016 File tab 

The File tab is different from other tabs because, instead of displaying a ribbon, it 
displays a list of submenus called the Backstage view. Clicking on any submenu 
on the Backstage view displays a different dialog box or window options. The 
Backstage view includes the submenus described in Table 2.1.

Table 2.1: Commands in the backstage view of MS PowerPoint file tab
No Command Description 

1 Info
Shows information about an active presentation 
and provides commands that control permissions, 
sharing, and version management

2 New   
Lists available templates, from which you can 
create a new presentation
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3 Open This allows you to find and open a presentation file 
on any storage media attached to your computer

4 Save 
This allows you to save changes made in the 
presentation you are working on

5 Save As

This allows you to save the presentation you 
are working on, using a different name. It also 
creates a copy of the active presentation and 
allows you to continue working with the copy of 
a presentation

6 Print This allows you to print your presentation

7 Share This allows you to share your presentation 
through various online platforms  

8 Export This allows you to save your presentation in a 
different format such as PDF

9 Close Closes the currently opened presentation 

10 Account Displays information about the Microsoft account 
you are signed in to

11 Options 
Opens the PowerPoint Options dialog box, from 
which you can configure many aspects of the 
software

Home tab
The Home tab displays a ribbon with different groups of commands that give 
you access to the most used commands, including Copy, Paste, Formatting, and 
the New Slide command. These commands are placed into groups: Clipboard, 
Slides, Font, Paragraph, Drawing, and Editing, as shown in Figure 2.8. The 
Home tab is a default selection, whenever you open the MS PowerPoint 2016 
program.

Figure 2.8: The Home ribbon

Insert tab 

The Insert tab has a ribbon that contains commands for allowing you to insert 
different objects into your presentation. Using commands of the Insert ribbon, 
you can insert things such as a new slide, table, picture, link, textbox, word art, 
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and special symbols. These commands are categorised into ten groups: Slides, 
Tables, Images, Illustrations, Add-ins, Links, Comments, Text, Symbols, and 
Media, as shown in  Figure 2.9. 

Figure 2.9: The Insert ribbon

Design tab

The Design tab has a ribbon that contains commands for allowing you to customise 
various aspects of your presentation. These commands are categorised into three 
groups: Themes, Variants and Customize, as shown in Figure 2.10. For example, 
the Themes commands group enables you to change the look and feel (overall 
appearance) of your presentation; variants allow you to modify the font of the 
presentation or the effects applied to the presentation elements, and they allow 
you to change the presentation background. The Customize group allows you to 
change the slide orientation from landscape to portrait and vice versa. 

Figure 2.10: The Design ribbon

NOTE: �Some commands are activated based on the type of slide pane you are 
using or an action you want to perform in your slide. For example, when 
you have a slide with a Table in it, table tools are activated, giving you 
an option to choose Table styles, as shown in Figure 2.11.

Figure 2.11: Table tools on the design ribbon

Transitions tab

The Transitions tab has a ribbon that contains commands for allowing you to add 
and customise effects that occur when you move (transition) from one slide to 
another. The transition ribbon contains three groups: Preview, Transition to This 
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Slide, and Timing, as shown in Figure 2.12. For example, you can customise the 
timing, specifying how long a transition should last. Also, the transition ribbon 
has many pre-created transition effects that you can use and/or customise. In 
addition, this ribbon has a command that allows you to preview the transition 
applied to a slide. 

Figure 2.12: The Transitions ribbon 

Animations tab

The Animations tab has a ribbon containing commands that allow you to add 
and customise the way text, images and other objects move as they appear on or 
disappear from a slide. These movements are called animations. For example, 
you can make a block of text appear to fly in a slide as it enters that slide. Figure 
2.13 shows the Animations ribbon.

Figure 2.13: The Animations ribbon

Slide Show tab

The Slide Show tab has a ribbon with different commands in three groups: Start 
Slide Show, Set Up and Monitors, as shown in Figure 2.14. 

Figure 2.14: The Slide Show ribbon

The Start Slide Show ribbon contains commands for displaying your slides in 
a presentation mode, which is also known as a slide show. In slide show mode, 
slides are displayed in full screen. For example, commands in the Start Slide 
Show group enable you to start a slide show from the first slide or from the 
current slide (the slide you are currently working on). The Set Up group contains 
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commands that enable you to rehearse your presentation and set up different 
aspects of a slide show. The configuration of display monitors for use during the 
presentation is done using commands from the Monitors group. For example, 
commands in the Monitors group enable you to use dual monitors to give your 
presentation.

Review tab

The Review tab has a ribbon that contains commands used to perform various 
editorial tasks. The commands in the Review tab are in six groups: Proofing, 
Insights, Language, Comments, Compare, and Ink, as shown in Figure 2.15. For 
example, the Proofing group contains commands for checking the spellings of 
a text in your slides and accessing reference materials such as dictionaries and 
encyclopedias. The Language group has commands for translating text from one 
language to another and for setting language preferences.

Figure 2.15: The Review ribbon

View tab
The View tab has a ribbon that contains commands in seven groups:  Presentation 
Views, Master Views, Show, Zoom, Color/Grayscale, Window, and Macros, as 
shown in Figure 2.16. 

Figure 2.16: The View ribbon

The Presentation Views group contains commands for viewing your presentation 
in different modes. For example, the Reading View command displays your 
presentation in full-screen mode for easy reading. The Master Views group 
contains commands that enable you to change the layout of slides, notes, and 
handouts. The Show group has commands that help you to organise the contents 
on your slides, including the Ruler, Guides, and Gridlines. These tools make it 
easier to arrange objects on your slides. Click the check boxes in the Show group 
on the View ribbon to show and hide these tools, as shown in Figure 2.17.
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Figure 2.17: Ruler, Guides, and Gridlines 

You can view your slides in different styles; the common views include the 
following. 

Normal view:  This is a default working view; it allows you to work on the 
current slide. 

Outline view: This is the left pane of the Normal view. It shows the list of slides 
that are being worked on and usually lists them in numbers. The view also allows 
you to find where you can insert a new slide, before or after a certain slide, if 
required. Likewise, you can use this view to delete unwanted slides.

Slide Sorter view: All slides in a presentation are displayed on a single screen. 
In Slide Sorter view, you can re-organise slides by dragging individual slides to 
different positions. You can also use this view to duplicate and delete slides. 

Notes Page view: Shows one slide at a time, along with any notes that are 
associated with the slide. This view lets you create and edit notes. You may find 
it easier to work with notes in this view than in the Normal view. You can also 
print notes for your presentation; notes will be printed as they appear in the Notes 
Page view. 

Reading view: This view is like the Slide Show view, except that it occupies a 
window rather than filling an entire screen. Displaying a presentation in a window 
enables you to work in other windows at the same time. 
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Slide Show view: This view portrays how your audience will see your presentation 
on a screen. In this view, a slide is displayed on a full screen. You cannot change 
or edit anything when you are in Slide Show view, unless you switch to normal 
view. 

Status bar

The status bar appears at the bottom of the screen. It provides information such as 
the number of the current slide, the total number of slides in your presentation, the 
language used, different view styles, and zoom options. For example, in Figure 
2.18, the status bar shows that presentation is on the 4th slide out of 5 slides, and 
the language used is English (United States).

Figure 2.18: The status bar

Hiding and showing the ribbon in MS PowerPoint 2016
The ribbon in MS PowerPoint is designed to respond to your current task, but 
you can choose to hide it if you find that it takes too much screen space. You can 
follow the steps in Activity 2.4 to hide and show the ribbon. 

Activity 2.4: Hiding and showing the Ribbon in MS PowerPoint 2016

(i)	 Click the Ribbon display options arrow. A drop-down menu will be 
displayed as shown in Figure 2.19. 

Figure 2.19: Ribbon display options

(ii)	 Select the desired display option from the drop-down menu.
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NOTE: 

1.	  �Auto-hide Ribbon: Displays a PowerPoint presentation in full-screen 
mode and completely hides the ribbon. To show the ribbon, click the 
Expand Ribbon (dotted line near the ribbon display options) command 
at the top of the screen.

2.	  �Show Tabs: This option hides all command groups when not in use, but 
tabs remain visible. To show the ribbon, simply click a tab.

3.	  �Show Tabs and Commands: This option shows the ribbon. All the tabs 
and commands will be visible. This option is a default selection when you 
open MS PowerPoint for the first time.

Closing a Presentation 
You are advised to save and close any opened presentation before you exit the 
MS PowerPoint 2016 program, or before you shut down your computer. Closing 
a presentation removes it from the screen. But MS PowerPoint 2016 continues 
running and so you can work with other presentation files. Use Activity 2.5 to 
practice closing a presentation.

Activity 2.5: Closing a presentation 

1.	 Click on the File tab to show the Backstage view. 

2.	 Click on Close. MS PowerPoint removes the presentation from the screen.

NOTE: �If you made some changes to your last saved presentation, PowerPoint 
will ask you to confirm your action by displaying a dialog box with 
three options: Save, Don’t Save, and Cancel.  Choosing Save will save 
changes to  the presentation before closing it. Choosing Don’t Save will 
close the presentation without saving changes. Choosing Cancel will 
neither close nor save changes to the presentation, but will return you to 
the presentation you are currently working on.

Exercise 	 2.1

1.	 What is the purpose of a presentation software? Give examples of scenarios 
where a presentation software can be used.

2.	 Describe common features of a presentation software and their importance.

3.	 Mention any three presentation software. Which one is mostly used today 
in your area  and why?  
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Preparing a presentation using MS PowerPoint 2016
A presentation in MS PowerPoint 2016 is made up of a series of slides. Slides 
contain the information you will present to your audience. This includes text, 
pictures, and charts. Information is usually presented in different slide layouts. 
There are several slide layouts, as shown in Figure 2.20. 

Figure 2.20: Slide Layouts

NOTE: �When preparing your slides, you need to select the type of layout based 
on the nature of the contents you want to put on a slide. For example, if 
your content is a two-column text, you may prefer a two-content layout, 
instead of a title and content layout.  

Creating a new presentation using MS PowerPoint 2016 
Creating a new presentation in MS PowerPoint 2016 is a straightforward task. 
After you have planned your content and opened MS PowerPoint, you can start 
adding your content in slides. Activity 2.6 guides you to create a new presentation 
in MS PowerPoint 2016. 

Activity 2.6: Creating a new presentation in MS PowerPoint 2016 

(i)	 On the Home ribbon, click the New Slide arrow,

(ii)	 Click the Title and subtitle slide layout; the slide view will be opened as 
shown in Figure 2.21.
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(iii)	 Type the title and subtitle of your presentation.   

Figure 2.21: Creating a title and subtitle of a presentation

By default, when you start a new presentation, the title and subtitle layout is 
displayed first, asking you to click to add a title and a subtitle, as shown in Figure 
2.21. The title and subtitle layout allows you to type a title and a subtitle only. You 
can add more slides as you wish, depending on the length and type of contents in 
your presentation.

Inserting a new slide 
Whenever you start a new presentation, it will contain one slide with the Title 
Slide layout. You can insert as many slides as you need from a variety of layouts. 
Follow the steps in Activity 2.7 to insert a new slide. 

Activity 2.7: Inserting a new slide 

(i)	 Click the Insert tab, 

(ii)	 On the Slides group of the Insert ribbon, click on the New Slide arrow; 
the office theme layout will appear. 

(iii)	 Choose the desired layout; in this case, click on the Title and Content 
layout (see Figure 2.22). A window similar to the one in Figure 2.23 will 
appear.
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Figure 2.22: Title and content slide layout

Figure 2.23: Window displayed after adding a new slide.

(iv)	 Type the title of your slide,

(v)	 To add a new slide of the same layout, click the New Slide button on the 
Home ribbon;  a new slide will be added.

(vi)	 Add the content to your slide,

(vii)	 To add a slide of a different layout, click the New Slide arrow,

(viii)	 Click on the layout you want to use for the new slide.
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Saving a presentation 
The procedure to save a presentation is the same as saving a file in other MS 
Office applications like MS Word and MS Excel. Follow the steps in Activity 2.8 
to save your presentation.

Activity 2.8: Saving a presentation in MS PowerPoint 2016

(i)	 Click on the File tab,

(ii)	 Click Save As,

(iii)	 Choose a location where you want to save your presentation,

(iv)	 Type the name of your presentation,

(v)	 Click Save. 

NOTE: �Both Save As and Save are used to save a presentation, but they do it 
differently, as described next.

1.	  �Save As: This command can be used in the following situations: 
when saving your document for the first time, when you want to 
create a new version of your presentation, and when you want to 
save your presentation in a different location or using a different 
name. 

2.	  �Save: This command is used for saving changes made to a document 
while you continue working on it. Clicking on Save overwrites the 
content of the previous version of a document. You can also use the 
shortcut Ctrl+S on your keyboard to save your presentation. 

Adding tables and charts in a presentation
Adding a table 

Tables are used to present data in rows and columns. Usually, columns and/or 
rows have labels or names that make it easy for the reader to make reference 
to the data in each table cell. MS PowerPoint 2016 allows the use of tables to 
present your data. This can be done by selecting the table icon in a slide pane and 
specifying the number of rows and columns, or using an Insert Table command 
to create a table. The procedure in Activity 2.9 guides you on how to add a table 
to your presentation. 

ICS FORM 4 COM FINAL .indd   36 13/03/2022   14:13



37

ICS

Activity 2.9: Adding a table to a presentation

There are two ways of inserting a table in a presentation: 

(i)	 Click on the Insert tab,

(ii)	 On Insert ribbon, click the arrow for table insertion,

(iii)	 Specify the number of rows and columns, and a table will be inserted,

	 Or 

(i)	 On the slide pane, click the put table icon,

(ii)	 On the Insert Table dialog box, specify the number of rows and columns 
(see Figure 2.24),

(iii)	  Click OK: a table will be inserted.

Figure 2.24: Insert Table dialog box

Adding a chart 

Charts are graphical representations of data. Features of charts include bars, 
lines, or columns that you can use to understand different trends or compare 
values. Charts created in MS PowerPoint 2016 can easily be modified to different 
forms. The procedure in Activity 2.10 will enable you to add a chart to your MS 
PowerPoint presentation.
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Activity 2.10: How to add a chart  

(i)	 Click on the Insert tab,

(ii)	 On the Insert ribbon, click the Chart icon,

(iii)	  On the Chart dialog box, choose the type of chart you want to insert,

(iv)	 Click OK.

	 Or 

(i)	 On the slide pane, click the icon for chart insertion,

(ii)	 On the Chart dialog box (see Figure 2.25), choose the type of chart you 
want to insert,

(iii)	 Click OK.

Figure 2.25: Insert Chart dialog box
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Adding sound to a presentation
MS PowerPoint 2016 offers tools that can assist you in adding sound to your 
presentation. These tools allow you to configure a sound object that will be played 
whenever you display the slide. You can also set a sound object by clicking the 
sound object icon. The procedure in Activity 2.11 guides you in adding sound to 
your presentation. 

Activity 2.11: Adding sound to a presentation 

(i)	 Select the slide to which you want to add the sound, 

(ii)	 Click on the Insert tab,

(iii)	 On the Insert ribbon, click the Audio button located on the right side, 

(iv)	 Choose the location where your audio file is found; for example, C:TIE/
Desktop/kingereza nyimbo: the Insert Audio dialog box will appear, as 
shown in Figure 2.26.

(v)	 Select the audio file you want to insert.

(vi)	 Click the Insert button to add sound.

Figure 2.26: The Insert Audio dialog box
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NOTE: �The buttons for playing a sound will be displayed on the slide, as shown 
in Figure 2.27.

Figure 2.27: A slide with a sound play button

Adding video to a presentation
You can also embed a video in a PowerPoint presentation or specify a link to a 
video file for use in a PowerPoint presentation. To do this, you can use a video 
file available on your PC or download one from the Internet or insert a link from 
the Internet. The procedure in Activity 2.12 guides you to insert a video into your 
presentation. 

Activity 2.12: Adding video to a slide 

(i)	 Select the slide to which you want to add a video, 

(ii)	 Click on the Insert tab,

(iii)	 On the Insert ribbon, click the Video button located on the right side, 

(iv)	 Choose the media or link that contains your video, 

(v)	 Select the video file you want to insert,

(vi)	 Click the Insert button.

Working with slides
PowerPoint presentations can contain as many slides as you may need. The 
Slide Navigation pane makes it easy to organise your slides. Using the slide 

Sound play buttons
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navigation pane, you can manipulate your presentation in different ways such as 
duplicating slides, rearranging slides, and deleting slides from your presentation.

Duplicating slides
 If you want to create a copy of a slide, you can duplicate it. To duplicate a slide, 
right-click on the slide and choose Duplicate Slide from the menu that appears. 
You can also duplicate multiple slides at once by selecting them first.

Moving slides
It is easy to change the order of your slides. To move a slide to a different position, 
drag the slide in the Slide Navigation pane to the desired position.

Deleting slides
If you want to remove a slide from your presentation, simply select the slide you 
want to delete, and then press the Delete or Backspace key on your keyboard.

Copying and pasting slides
If you want to create several slides with the same layout, you may find it easier 
to copy and paste a slide you have already created, instead of starting with an 
empty slide. Follow the procedure in Activity 2.13 to copy and paste slides.

Activity 2.13: Copying and pasting slides 

(i)	 In the Slide Navigation pane, select the slide you want to copy,

(ii)	 Click the Copy command on the Home ribbon,

(iii)	 In the Slide Navigation pane, click just below a slide (or between two 
slides) to choose a paste location. A horizontal insertion line will appear.

(iv)	  Click the Paste command on the Home ribbon or use a keyboard shortcut 
“Ctrl + V”, the slide will appear in the selected location.

NOTE: �You can also copy a slide by right-clicking on it and selecting Copy from 
the menu that appears, and then right clicking to choose the Paste option. 

Customising slides
Customising a slide means changing the default settings of a slide to user-defined 
settings. There are several options to customise a slide, including changing the 
slide size, formatting slide background, applying a theme, applying animations, 
and applying transitions. 
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Changing on-screen show slide size
By default, all slides in MS PowerPoint 2016 use a 16:9 on-screen show slide 
size known as the widescreen aspect ratio. Widescreen slides will work best 
with widescreen monitors and multimedia projectors. However, if you need your 
presentation to fit on a standard 4:3 screen, it is easy to change the on-screen slide 
show size to fit on that screen. The steps in Activity 2.14 guide you on how to 
change the on-screen slide show size. 

Activity 2.14: Changing the on-screen show slide size 

(i)	 On the Design ribbon, click on the Slide Size command (see Figure 2.28), 

Figure 2.28: Changing on-screen show slide size 

(ii)	 Choose the desired on-screen show slide size from the menu that appears.

	
�Alternatively, you can follow the following steps to change the on-screen show 
slide size.

(i)	 Using the slide size command on the design ribbon, click on Custom 
Slide Size,

(ii)	 Use the slide size dialog box (see Figure 2.29) to set up the on-screen 
show size of your slides. 
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Figure 2.29: On-screen show Slide Size dialog box

Formatting slide background
By default, all slides in your presentation use a white background. It is easy to 
change the background style for some or all your slides. Examples of backgrounds 
you can use are solid fill, gradient fill, pattern fill, and picture fill. Follow the 
steps in Activity 2.15 to practise how to change the slide background. 

Activity 2.15: Changing the slide background 

(i)	 On the Design ribbon, click the Format Background command. The 
Format Background pane will appear on the right (see Figure 2.30). 

(ii)	 Select the desired fill option,

(iii)	 Click Apply to All to apply the selected background style to all slides in 
your presentation.
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Figure 2.30: Changing the slide background

Applying a theme
A theme is a predefined set of colours, fonts, and effects that may be used to 
instantly change the look and feel of your presentation. Follow the procedure in 
Activity 2.16 to change the theme of your slides. 

Activity 2.16: Changing a slides theme

(i)	 On the Design ribbon, click the More drop-down arrow: a window with 
all the available themes will appear (see Figure 2.31).

(ii)	 Select the desired theme and it will be applied on your slides. 

Figure 2.31: Applying a theme to slides
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NOTE: �Some themes will work better than others, depending on the contents of 
your slides. 

Applying animations
Animations make objects appear to move on the screen. In a PowerPoint 
presentation, things like text and graphics can be made to move around a slide 
(animated). Animations are very useful in making a presentation more dynamic 
and help to emphasise points. However, you should be very careful in using 
animations because too much of them can distract the audience. In MS PowerPoint 
2016, animations can be used to signal entrance to a slide, to emphasise objects 
on a slide, and to signal exit from one slide (see Figure 2.32). 

Figure 2.32: Categories of animation in MS PowerPoint 2016

Important points in adding animations

(a)	 Use simple animations as much as possible.

(b)	 Avoid unnecessary use of too many animations. 

(c)	 Adjust the timing of an animated object to suit the needs of a presentation.

The procedure in Activity 2.17 guides you in applying animations to your 
presentation. 

ICS FORM 4 COM FINAL .indd   45 13/03/2022   14:13



46

ICS

Activity 2.17: Setting animations in a presentation

(i)	 Click on the Animations tab,

(ii)	 On the Animations ribbon, choose the animation style you want to use,

	� Or,

If you prefer a certain animation that is not in the default ones, follow the 
following steps. 

(i)	 On the Animations ribbon, click the More arrow: more animation styles 
will appear, as shown in Figure 2.33. 

(ii)	 Choose the animation style you want to use.

Figure 2.33: Animation style options

NOTE: �If you want to apply the same animation to all text or objects in a slide, 
you can select all text or objects, and then click on the command for 
animation you prefer. 

Applying transitions
Transitions refer to animations applied when moving from one slide to another. 
There are many transition options available in the Transitions ribbon of MS 
PowerPoint. These transitions are divided into three categories: subtle, exciting, 
and dynamic content, as shown in Figure 2.34. 
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Figure 2.34: Categories of transitions in MS PowerPoint 2016

NOTE: �Transitions can help you to automatically move from one slide to the 
next, without clicking anywhere. The steps in Activity 2.18 guide you on 
how to set transitions for your presentation. 

Activity 2.18: Setting transitions 

(i)	 Select the slide to which you want to introduce a transition, 

(ii)	 Click on the Transitions tab, 

(iii)	 On the Transitions ribbon, choose the required transition (see Figure 
2.35), 

(iv)	 Click the More arrow, if you want to explore more types of transitions, 

(v)	 Click the Apply to All button if you want to apply the transition to all 
slides. 

Figure 2.35: Transitions window 
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Exercise 	 2.2
Prepare a presentation that contains ten slides about yourself, your family, friends, 
and your schools. Apply a transition of your choice to all the slides. Also, apply 
animations to at least three relevant slides in your presentation. 

Customising slide layouts
Sometimes, the available slide layouts may not suit your needs. For example, the 
layout may have too many or too few placeholders.  Likewise, you may find it 
necessary to rearrange the placeholders on the slide. This is quite simple when 
using MS PowerPoint 2016 because it gives a way to adjust slide layouts as 
needed.

Adjusting placeholders
You can adjust a placeholder by moving or resizing it. To adjust a placeholder, 
you need to select it first. To select a placeholder, hover the mouse over the 
edge of the placeholder and click (you may have to first click on the text in 
the placeholder to see the border). A selected placeholder will have a solid line 
instead of a dotted line, as shown in Figure 2.36.

Figure 2.36: Placeholder with a solid line

To move a placeholder, select the placeholder (Figure 2.37), then click and drag 
it to the desired location.
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Figure 2.37: Placeholder with the moving handle

To resize a placeholder, select the placeholder you want to resize. Sizing 
handles will appear (see Figure 2.38). Click and drag the sizing handles until 
the placeholder is of desired size. You can use the corner sizing handles to change 
the placeholder’s height and width simultaneously.

Figure 2.38: Placeholder with resizing handles

Deleting a placeholder
Select the placeholder you want to delete, and then press the Delete or Backspace 
key on your keyboard.

Adding a text box
Text can be inserted into both placeholders and text boxes. Inserting text boxes 
modifies a slide layout. Unlike placeholders, text boxes always stay in the same 
place, even if you change the theme. The procedure in Activity 2.19 guides you 
to add a text box to a placeholder. 

Activity 2.19: Adding a text box to a placeholder
(i)	 On the Insert ribbon, select the Text Box command,
(ii)	 Click, hold, and drag to draw a text box on the slide. The text box will 

appear as shown in Figure 2.39.

Figure 2.39: A text box
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Using blank slides
Blank slides with no placeholders are a good option if you want to organise your 
content in your own style. Blank slides can be altered to include your own text 
fields, images, charts, and other elements. Activity 2.20 guides you on how to 
insert and use a blank slide. 

Activity 2.20:  Using blank slides 

(i)	 Click on the Insert tab,

(ii)	 On the Insert ribbon, click on New Slide command, 

(iii)	 Choose Blank from the menu that appears.

NOTE: �When you use blank slides, you will not have the freedom to use pre-
designed layouts that come with each theme.

Playing the presentation slides
After you have prepared your presentation, you may play your slides using Slide 
Show mode. A slide show is used both to test your presentation and for delivering 
a presentation. The quickest way to play your presentation is to use the Start 
From Beginning command. The steps in Activity 2.21 enable you to run your 
slides.

Activity 2.21: Playing your presentation

(i)	 On the Slide Show ribbon, click on the Start From Beginning command: 
the presentation will appear in full-screen.

(ii)	 Click a left mouse button or use a space bar to move to the next slide. You 
can also use the arrow keys to move from one slide to another.

(iii)	 Press the Esc key to exit the presentation mode.

Exercise 	 2.3
Use your computer to modify any existing presentation by doing the following. 

1.	 Open an existing presentation.

2.	 Insert a new slide with the Title and Content layout.

3.	 Add some text to the title placeholder.
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4.	 Change the layout of the slide to a layout of your desire.

5.	 Move the slide in step 4 to a new location by using Copy and Paste 
commands. 

6.	 Apply a theme to your presentation. If you have applied another theme 
before, change it to the Integral theme.

7.	 Insert a blank slide, and then insert a text box on the slide.

8.	 Change the slide size from Widescreen to Standard.

Exporting presentations
MS PowerPoint, like other Microsoft Office applications, can export presentations 
to different file formats such as a portable document format (PDF), as well as 
file formats that are specific to previous versions of PowerPoint. Exporting a 
presentation to other file formats follows the same procedure as saving a file for 
the first time, except that you must choose a different file format for saving your 
document.

Saving your presentation as a PDF file

Follow the procedure in Activity 2.22 to save a presentation as a PDF file.

Activity 2.22: Saving a presentation as a PDF file

(i)	 Click on the File tab, 

(ii)	 In the Backstage View, click Save As,  

(iii)	 Select a location on your computer to which you want to save the file, 

(iv)	 From the Save as type drop-down menu, choose PDF,

(v)	 Click Save.

Saving your presentation as a video file 

MS PowerPoint 2016 also allows you to export your presentation to a video 
format. The steps in Activity 2.23 guide you in saving your presentation as a 
video. 

Activity 2.23: Saving your presentation as a video

(i)	 Click the File tab to access the Backstage view,
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(ii)	 On the Backstage view, click Export: the Export dialog box will appear, 
as shown in Figure 2.40.  

Figure 2.40:  Exporting a presentation. to a video file format

(iii)	 Choose the desired option; in this case, select Create a Video: the sub-
window for creating the video will appear, 

(iv)	 Click the Create video button, and the window for specifying file 
information will be opened. 

(v)	 Specify the file name, 
(vi)	 Click Save.

NOTE: �The steps in Activity 2.23 can also be followed to export the presentation 
to PDF, package it to a CD or flash disk, create handouts, and change file 
type. 

Sharing presentations
MS PowerPoint 2016 makes it easy to share and collaborate on presentations 
using OneDrive, which is a file hosting and synchronization service managed 
by Microsoft.  Microsoft OneDrive is like Google Drive. When you use MS 
PowerPoint 2016 to share a presentation, you let others access the same file. 
This lets you and your collaborators edit the same presentation, without having 
to keep track of multiple versions. To share a presentation, it must first be saved 
to your OneDrive account. Follow the procedure in Activity 2.24 to share your 
presentation.

  

1

2

3
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Activity 2.24: Sharing a presentation 

(i)	 Click on the File tab,

(ii)	 On the Backstage view, click on Share: the Share pane will appear as 
shown in Figure 2.41.

Figure 2.41: Sharing a presentation.

(iii)	 Click on Save to Cloud,

(iv)	 Click on Browse,

(v)	 Specify a file name,

(vi)	 Click Save.

NOTE: A digital presentation can be shared in different ways, including email, 
online presentation platforms, or via storage devices such as CD or flash 
disk. Sharing of a presentation via a CD or flash disk can be appropriate 
if the presentation is to be done physically. A presentation saved on 
external storage such as external hard disk, Flash disk or CD can be 
shared to other computers. Sharing the presentation via email is done 
as an attachment. The existing online options enable you to present to 
a remote audience, who can view your presentation via a web browser 
or via video conference tools such as Zoom, Google Meet, or Skype. 

3
21
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Exercise 	 2.4
In this exercise, you are going to create, save, share, and export a presentation. 
The following steps guide you on how to accomplish the task.

1.	 Create a new presentation.

2.	 Save the presentation on the Desktop.

3.	 Save the presentation online and invite someone else to view it.

4.	 Export the presentation to a PDF file.

Linking a presentation file to other documents
A hyperlink enables you to link a text or an image to another file. It makes it 
possible to link additional content to your presentation. To elaborate a certain 
point during the presentation, you may use a hyperlink to access a linked object. 
MS PowerPoint 2016 enables you to link your slides to files, other slides, web 
addresses, or e-mail addresses. You are required to create a hyperlink that can be 
clicked easily. 

Inserting a hyperlink to an existing file 
Hyperlinks have two basic parts: the address of the data source you want to 
connect to, and the text to be displayed. For example, if you want to connect to 
YouTube, the address could be http://www.youtube.com, and YouTube could 
be the content to be displayed. But sometimes, the content to be displayed might 
be the same as the address. You need to specify the address as well as the content 
or image that will be displayed when creating a hyperlink in PowerPoint. The 
procedure in Activity 2.25 guides  you on how to insert a hyperlink to your 
presentation. 

Activity 2.25: Inserting a hyperlink to a presentation 

(i)	 Select the text or image you want to link to another file,

(ii)	 Click the Insert tab, 

(iii)	 On the Insert ribbon, click the Hyperlink command: the Insert 
Hyperlink dialog box will be opened, as shown in Figure 2.42,

(iv)	 Type the address of the file, or select the file you want to link to your slide, 

(v)	 Click OK. 
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Figure 2.42: The Insert Hyperlink dialog box

NOTE: �The file may be selected from a recent file or other sources by clicking 
on the Browsed Pages command on the dialog box. 

Linking a PowerPoint Slide to an e-mail address
Activity 2.26 guides you on how to insert a hyperlink to an email address.

Activity 2.26: Inserting a hyperlink to an e-mail address 

(i)	 On a slide, select the text or image you want to link to an email, 

(ii)	 On Insert ribbon, click the Hyperlink command. The Insert Hyperlink 
dialog box will be opened.

(iii)	 Click Email Address,

(iv)	 In the Email Address box, type the e-mail address you want to connect 
to, 

(v)	 Click OK. The text will change colour to indicate a hyperlink, as in Figure 
2.43.
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Figure 2.43: A slide with a hyperlink.

Opening a hyperlink

You are advised to test your hyperlinks to see if they work as expected. This 
is done by right-clicking on the hyperlink and then clicking on Open Link, as 
shown in Figure 2.44.

Figure 2.44: Opening a hyperlink
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Removing a hyperlink
You may find that the links you have introduced to your slide or document are 
no longer needed; MS PowerPoint 2016 allows you to remove them. To remove 
a hyperlink from the slide, right-click on the hyperlink and then click on the 
Remove Hyperlink menu option. 

Inserting action buttons
Action buttons are built-in shapes that can also be used to link your slides to a 
web page, file, e-mail address, or another slide show. A button acts as a hyperlink, 
which, when clicked, it opens the specified location or object. You can insert 
action buttons on one slide at a time, or you can insert an action button that will 
appear on every slide. Action buttons can help you to link your slide to or back 
to a specific slide. The procedure in Activity 2.27 guides you on how to insert an 
action button into your presentation. 

Activity 2.27: Inserting an action button on a slide

(i)	 Click on the Insert tab.

(ii)	 On the Insert ribbon, click the Shapes command in the Illustrations 
group. A drop-down menu will appear with the action buttons, as shown 
in Figure 2.45.

Figure 2.45: Action buttons
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(iii)	 Select the desired action button,

(iv)	 Insert the button onto the slide by clicking on the desired location. The 
Action Settings dialog box will appear, as shown in Figure 2.46.

(v)	 Select the Mouse Click or Mouse Over tab, 

Figure 2.46: Action Settings dialog box.

NOTE: �Selecting the Mouse Click tab means the action button will perform an 
action only when clicked. Selecting the Mouse Over tab will make the 
action button perform an action when you move the mouse over it.

(vi)	 From the Action on click section, select Hyperlink to,  

(vii)	 From the Hyperlink to drop-down menu, choose Next Slide option, as 
shown in Figure 2.47.
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Figure 2.47: Specifying hyperlink destination for an action button 

(viii)	 Select the Play Sound box, if you want a sound to play when the action 
button is clicked. 

(ix)	 Select the type of sound from the drop-down menu, or select other sounds 
from your computer, as shown in Figure 2.48.
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Figure 2.48: Adding a sound to an action button 

(x)	 Click OK. The action button will appear as in Figure 2.49. 
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Figure 2.49: A slide with an action button

Inserting an action button to all slides

MS PowerPoint 2016 allows you to apply an action button to all slides at once. 
The procedure in Activity 2.28 guides you to insert an action button to all slides 
at once. 

Activity 2.28: Inserting an action button to all slides

(i)	 Click the View tab, 

(ii)	 On the Master Views group, click the Slide Master command: a blank 
slide will appear in your presentation. 

(iii)	 Click the Insert tab, and follow the instructions to add an action button 
to a slide,  

(iv)	 Click the Slide Master tab, 

(v)	 Click Close Master View, and the new action button will be displayed 
on every slide.

ICS FORM 4 COM FINAL .indd   61 13/03/2022   14:13



62

ICS

Testing an action button
It is advised to test your action button after you have created it. Follow the 
procedure in Activity 2.29 to test the action button you have created. 

Activity 2.29: Testing an Action Button 

(i)	 Click the Slide Show tab,

(ii)	 In the Start Slide Show group of the Slide Show ribbon, click From 
Current Slide, as shown in Figure 2.50.  

(iii)	 Click your action button, and observe what will happen. 

Figure 2.50: A slide show from current slide for testing an action button

Editing an action button
After you have created an action button, it is possible to edit it. The procedure for 
editing an Action Button is presented in Activity 2.30.  

Activity 2.30: Editing an action button

(i)	 Select the action button,

(ii)	 Click the Insert tab, 

(iii)	 In the Links group of the Insert ribbon, click the Action command: the 
Actions Settings dialog box will appear.

(iv)	 Edit the action or hyperlink,

(v)	 Click OK.

Changing the appearance of an action button
The action button can be modified in a way preferred by the designer. To make 
changes to an action button, you can follow the procedure in Activity 2. 31. 

Activity 2.31: Changing the appearance of an Action Button

(i)	 Select the action button, 
(ii)	 Click the Format tab, 
(iii)	 On the Format ribbon, use the tools in the Shape Styles group to change 

the button style or colour.
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Exercise 	 2.5

1.	 Open an existing PowerPoint presentation. 

2.	 Select a text and insert a hyperlink to a webpage of your choice. 

3.	 Select a text or an image and insert a hyperlink to another slide in the 
presentation. 

4.	 Insert an action button that uses sound. 

5.	 Change the shape and style of an action button. 

Delivering a presentation
After you have prepared your slides, the next step is to deliver a presentation. 
If your presentation will be face-to-face, you will need to prepare yourself by 
connecting the multimedia projector to your computer and using slide show 
mode.

Connecting a multimedia projector to a computer
All modern TVs and projectors have one or more ports that allow them to be 
connected to a computer. Both desktop and laptop computers can connect to a TV 
or a multimedia projector, only if appropriate cables are used. You are supposed 
to follow the instructions for using a TV or multimedia projector as a computer 
monitor. Areas of focus include the following:

(i)	 Identifying available connections.

(ii)	 Connecting a computer to a multimedia projector or TV.

(iii)	 The type of data source, either a desktop computer or a laptop.

(iv)	 Troubleshooting connection problems, if there is any. 

Identifying available connections
The first step in connecting your computer to a TV or projector is finding 
appropriate ports on both devices. These can be Video Graphics Array (VGA) 
ports, High-Definition Multimedia Interface (HDMI), or Universal Serial Bus 
(USB). After  identifying ports, you must connect the two devices with the correct 
cable. Figure 2.51 shows available connection ports on a typical multimedia 
projector.

ICS FORM 4 COM FINAL .indd   63 13/03/2022   14:13



64

ICS

Figure 2.51: Connection ports on a multimedia projector

High-Definition Multimedia Interface 
The High-Definition Multimedia Interface (HDMI) connection is popular among 
display electronics appliances. Nearly all modern televisions and multimedia 
projectors have HDMI ports. A lot of laptop computers have HDMI ports, and the 
HDMI ports are becoming more prevalent on desktop computers as well, even 
those without a high-end video card. HDMI is quickly becoming the standard 
for all electronic equipment, because of its high-quality signals and the ability 
to carry audio and video signals. Figure 2.52 shows an example of HDMI cable.

Figure 2.52: Examples of  HDMI cable

Video Graphics Array 

The Video Graphics Array (VGA) connection is also another type of connection 
on both desktop and laptop computers. It is also common on multimedia projectors 
and some Liquid Crystal Display (LCD) and Light Emitting Diode (LED) TV 
panels. The VGA cable has a 15-pin connector on each end that can be plugged 
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into a VGA port on each device being connected. Since modern designs do not 
support VGA connections, it is recommended to use HDMI cables due to their 
wide range of compatibility. Figure 2.53 shows an example of VGA cable.

Figure 2.53: Example of  VGA cable

Digital Visual Interface 

The Digital Visual Interface (DVI) connection is newer than VGA and offers 
sharper images. Although the DVI port is not shown on the projector’s image 
in Figure 2.51, it is still somewhat common on multimedia projectors, but not 
common on TVs. It is mainly found on desktop computers and is used for 
connecting monitors. Also, some laptops have DVI connections as well. Because 
it is difficult to find a DVI port on a TV or multimedia projector, it is recommended 
to use HDMI cables, if available. Figure 2.54 shows a DVI cable. 

Figure 2.54: Example of a DVI cable
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S-Video

The super video (S-Video) connection is also commonly found on TVs (see Figure 
2.55) and multimedia projectors, but seldom on a desktop or laptop computer. 
This connection is almost obsolete.

Figure 2.55: S-Video connection ports and cables

The S-video connection is quite common on TVs and projectors, but it is nearly 
non-existent on modern computers. This connection has a three-cable bundle 
consisting of red, white, and yellow ports for audio. You can see this set up on 
older video cards for desktop computers.

Universal Serial Bus 

Universal Serial Bus (USB) is an industry connection standard used for short-
distance digital data communications. A USB cable (see Figure 2.56) is a standard 
cable connection interface for personal computers and consumer electronics 
devices. USB ports allow devices to be connected using USB cables, to transfer 
digital data. They can also be used to supply electric power across the cable to 
devices that need power. Recently, USB is becoming a standard connector for 
connecting a computer or laptop to a projector or TV, charging mobile phones, 
power banks, etc. 
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Figure 2.56: A USB cable

Connecting a computer to a multimedia projector or TV
After identifying what connection ports are available on your computer, TV, or 
multimedia projector, you can then connect the devices. The following instructions 
can assist you in connecting the devices. 

Desktop Computers

To connect a desktop computer to a display device of interest, plug the cable into 
the computer and an output the device. This can take several steps as follows: 

(i)	 Disconnect the VGA cable from the computer monitor, 

(ii)	 Connect the splitter to the VGA port of the projector (see Figure 2.57)

Figure 2.57: VGA splitter connected to a projector 
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(iii)	 Connect the other end of the splitter to the system unit port (see Figure 
2.58). 

Figure 2.58: VGA splitter connected to the computer 
(iv)	 Make sure the projector’s power cable is plugged into an electrical outlet. 

(v)	 All projectors have an on/off switch. Press once to power on the lamp. 
Press twice to power off the lamp. The fan will continue to run after the 
lamp is powered off. Do not unplug the projector from the power source 
until the fan stops running. 

(vi)	 Adjust the projector’s foot to get the correct height for your projector. 

(vii)	 For some projector models, you can adjust the focus using “focus” or 
“zoom” buttons on a projector. Other projectors have a “dial” around the 
lens on the front part of a projector. 

VGA Splitter

ICS FORM 4 COM FINAL .indd   68 13/03/2022   14:13



69

ICS

VGA Splitter

If you do not see an image, you may have to change the display using the 
following steps.

1.	 On your computer, press the Windows Key,
2.	 Type Adjust screen resolution and press Enter,
3.	 Find Display and click the down arrow on the right-hand side of the box,
4.	 Select the appropriate output device, 

5.	 Click Apply, and then click OK.
Laptop Computers

If you connect a laptop computer to a TV or a projector, you will often need to 
“send” a video signal to a display device. The sequence of keys to do this varies 
depending on the laptop manufacturer brand, but it is often one of the following 
keyboard key combinations: Fn + F3, F4, F5, F8, or F9. For example, pressing 
and holding Fn + F3 simultaneously on the keyboard sends the video signal to the 
connected TV instead of the laptop’s screen. For other laptops, a key for Fn might 
have a picture of a monitor. 

Switching TV inputs
If you connect a computer to a TV, ensure that the TV is set to a correct input 
channel. For example, if you connect the HDMI cable to your computer and 
then connect the same cable to the “HDMI 2” port on your TV, you may  need 
to switch to the “HDMI 2” input channel on the TV. This action can usually be 
accomplished by pressing the input button on the remote control of your TV until 
the correct input channel is selected.

Setting up the slide show
After you have made all the connections the next step is to play your slides in Slide 
Show mode. Microsoft PowerPoint 2016 has various options for setting up and 
playing a slide show. For example, you can set up an unattended presentation that 
can be displayed at a kiosk, making your slide show repeat itself continuously. 
The steps in Activity 2.32 guide you on how to set up the slide show.

Activity 2.32: Setting up a slide show

(i)	 Click Slide Show tab, 

(ii)	 On the slide show ribbon, click the Setup Slide Show command. The Set-
Up Show dialog box will appear as in Figure 2.59. 

(iii)	 Select the desired options for your presentation,

(iv)	 Click OK.
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Figure 2.59: Set Up Show dialog box

Project 1: Playing a slide show 

1.	 Create a PowerPoint presentation of at least nine slides on any topic of your 
choice.

2.	 Practice playing a slide show and navigating through the slides.

3.	 Change your mouse pointer to a pen or highlighter and try marking a slide: 
add a chart on slide 8 and mark it.

4.	 Try using the Presenter view.

5.	 Open the Setup Show dialog box and try to modify the options.

6.	 Submit the created presentation in soft copy. 

Printing a presentation document
Several options are available for printing the presentation document, depending 
on the purpose. For example, a custom version of a presentation can be printed to 
help the audience follow the slides during your presentation. Printed presentations 
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can also serve as handouts, which the audience can also use for taking notes. Print 
settings are done using the printing pane, by performing page setup to specify 
what you want to print from the slides. 

Performing page setup before printing your presentation
MS PowerPoint 2016 has several layouts you can use when printing a presentation. 
The layout you choose will mostly depend on why you are printing the slides. 
There are four different print layouts, as described next.

Printing full-page slides
This layout prints a full page for each slide in your presentation. It is a layout 
that would be most helpful if you need to review or edit a printed copy of your 
presentation. The procedure in Activity 2.33 guides you to set up full-page slide 
printing. 

Activity 2.33: Full-page slide printing

(i)	 Click the File tab,

(ii)	 Click the Print tab: the printing set-up window will appear as shown in 
Figure 2.60. 

(iii)	  In settings options, select Print All Slides,

(iv)	  Select Full Page Slides in the Slides option,   

(v)	 Click the Print icon. 

Figure 2.60: Slides printing set-up
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Printing Notes
This layout prints each slide, along with any speaker’s notes for the slide. If you 
have a lot of notes for each slide, you could keep a printed copy of the notes with 
you while presenting.

Printing an outline
This layout prints an overall outline of the slide show. You could use this layout 
to review the organisation of your slide show as you prepare to deliver your 
presentation. Activity 2.34 guides you on how to print an outline of your slides.  

Activity 2.34: Printing the outline of slides

(i)	 Click the File tab,

(ii)	 Click the Print tab, 

(iii)	 In setting and printing layout options, select Print All Slides, 

(iv)	 Select Outline in a Slides option: the printing set-up window will appear 
as shown in Figure 2.61.

(v)	 Click Print icon. 

Figure 2.61: Printing the outline of slides

Printing Handouts
This layout prints thumbnail versions of each slide, with optional space for notes. 
It is especially useful if you want to give your audience a physical copy of the 
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presentation at the time of presentation delivery. The optional space allows them 
to take notes on each slide. Activity 2.35 guides you to print slides as handout. 

Activity 2.35: Printing slides as a handout 

1.	 Open an existing PowerPoint presentation. 

2.	 Preview the presentation in the Print pane.

3.	 Print a Handout version of the presentation, with three slides per page. 
Figure 2.62 shows an example of Handout slides printout. 

Figure 2.62: Handout slides printout
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Exercise 2.5 
Review Questions

A. True or False questions
Write T for a true statement and F for a false statement 
1.	 MS PowerPoint 2016 is a software used to prepare documents such as 

letters and reports___

2.	 In MS PowerPoint 2016, content is organized in slides___

3.	 The only option available when preparing a presentation using MS 
PowerPoint 2016 software is to use the built-in templates___

4.	 The arrangement of items in a slide is known as templates___

5.	 There are several versions of MS PowerPoint apart from MS PowerPoint 
2016 ___

6.	 In an MS PowerPoint window, an area that displays the file name is known 
as the title bar___

7.	 When presenting, slides need to be viewed in a normal view___

8.	 Individual elements in the menu bar of MS PowerPoint 2016  are known 
as tabs___

9.	 The Save option in the file tab of MS PowerPoint 2016  is used when you 
want to save your presentation for the first time___

10.	 A part of MS PowerPoint 2016 window that displays information such as 
number of slides and language used is known as the status bar___

B. 	 Multiple choice questions
Choose the most correct answer and circle it 

1.	 The following are presentation software except: 
(a)	 SlidesDog
(b)	 Canva
(c)	 MS Access
(d)	 Google Slides

2.	 The following terms provide a clear meaning of slide layout except:
(a)	 Arrangement of items 
(b)	 Movement of items
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(c)	 Outline of items
(d)	 Organisation of items 

3.	 A tab that can be used to change the background colour of slides in a 
presentation is:
(a)	 Home
(b)	 Insert 
(c)	 Design 
(d)	 Animations

4.	 ______is a view in MS PowerPoint used when you want to delete or change 
the order of slides:
(a)	 Normal view
(b)	 Slide show view
(c)	 Slide sorter view 
(d)	 Outline view 

5.	 Which function key on a keyboard is used to start a slide show view?
(a)	 F2				   (b)    F3 

         (c)     F4				   (d)    F5

6.	 A text or image that has been linked to another file in MS PowerPoint is 
known as:
(a)	 Link 
(b)	 Hyperlink 
(c)	 URL
(d)	 Object link 

7.	 The following are cables which can be used to connect an LCD projector 
to a computer except:
(a)	 HDMI cable
(b)	 VGA cable 
(c)	 USB cable 
(d)	 Ethernet cable 
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8.	 The Backstage view of the file tab in MS PowerPoint 2016 contains the 
following options except:
(a)	 New			   (b)    Open 

         (c)     Print 			   (d)    View 

9.	 The default size of all slides in MS PowerPoint 2016 is___
(a)	 16:9			   (b)    16:8 

         (c)     16:4			   (d)    16:2

10.	 Which function key on a keyboard is used to switch a presentation from a 
Slide Show view to a Normal view is__
(a)	 F12			   (b)    Esc 

         (c)     Tab			   (d)    End

C.	 Short answer questions 
Answer the following questions 

1.	 What is a presentation program? How are it used?

2.	 Assume there is graduation ceremony in your school and you have been 
invited as head prefect to give a speech about the importance of school 
environment conservation. Prepare a ten (10) slides presentation to be 
presented to the audience during the ceremony. 

3.	 Present and analyse three (3) precautions which should be taken when 
adding animations to a presentation you have prepared. 

4.	 Differentiate between transitions and animations as applied in MS 
PowerPoint 2016. 

5.	 Describe the steps of adding a video clip to a presentation prepared using 
MS PowerPoint 2016. What is the advantage of adding a video to a 
presentation? Give examples of scenarios in which videos can be added to 
a presentation. 

6.	 What are the differences between MS PowerPoint, Google Slides, and 
Open Office Impress? What situations are suitable for use of each of the 
three presentation software?
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The concept of desktop publishing
There is always a need to develop and produce publications such as advertisements, 
invitation cards, hotel menu lists, calendars, banners, greeting cards, and books. 
This can be easily done using a software known as Desktop Publishing (DTP) 
software. DTP refers to the use of a personal computer to create different kinds 
of publication materials. A DTP software enables us to combine texts, images, 
charts, and other visual elements into a single document. These documents 
can be published in two forms: electronic and printed. Examples of electronic 
publications are e-newsletters, while examples of printed publications are 
hardcopy of brochures and calendars. A Desktop Publishing Software allows the 
user to manage visual content of a publications, including page layout and design. 

DTP creates high quality products, with an appearance that is better than that 
produced by word processing software. For example, professionals use DTP 
software to create documents such as certificates, brochures, business cards, 
web pages, catalogues, annual reports, fliers, letterheads, newspapers, booklets, 
logos, posters, and magazines. DTP enables creativity in producing high quality 
materials by allowing the designer to easily try out various styles such as page 

Chapter

Using Desktop Publishing Software

03

Introduction
The world is full of art. Artworks facilitate translation of the imaginary world 
into reality. Artworks can be presented as text, pictures, and drawings to 
represent things such as buildings, furniture, and clothes. Created by hand 
or using different software, artworks can be presented and published on 
paper or other printing materials. Common works of art in our environment 
include birthday cards, billboards, hotel menu lists, calendars, posters, and 
brochures. In this chapter, you will learn how to use Desktop Publishing 
Software to develop and produce publications for different purposes. The 
competence developed in this chapter, will enable you to prepare different 
kinds of publication using Desktop Publishing Software. 
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layouts, fonts, and colours. Examples of DTP software are Microsoft (MS) 
Publisher, PageMaker, Express Publisher, Ventura Publisher, Adobe Creative 
Suite, and QuarkXPress. This book uses Microsoft Publisher 2016 due to its 
popular use and availability as part of Microsoft Office software package. 

DTP terminologies and types of publication
Several terminologies are used when working with DTP software. To be able 
to effectively use DTP software, you need to understand these terminologies. 
It is also important to be familiar with different kinds of publication that can be 
produced by DTP software; this will enable you to decide whether a task at hand 
can be done using a DTP software.

Terminologies 
Publication: In general, publication refers to an act of making the content of some 
material available to the public. In this chapter, publication refers to the process of 
making a document more attractive using a DTP software.

Printing: The act of producing a hard copy of a publication such as a letter, a 
book, a newspaper or other material using a printing machine (printer, plotter, 
etc.).

Sharing: In this context, sharing refers to a process of making a designed publication 
material available for others to access. Sharing can be done via online platforms 
such as websites and social media.

Graphics Design: This refers to an act of combining ideas into a visual 
representation that can deliver a specific message. It involves designing objects, 
images, and pictures in different shapes and colours to suit the needs of users.

Types of Publication
DTP software can be used to design different types of publication. The following 
are common types of publication.

Newsletter: A newsletter is a publication that is shared periodically, focusing 
on one main topic of interest to its subscribers that can be institutions, business 
firms, and government agencies.

Brochure: A brochure is a type of leaflet with brief information about an 
organisation, a product, or a service. 

Flyer: A flyer (also called a circular, handbill, or leaflet) is a short publication 
with information for advertising an organisation, an event, a service, or other 
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aspects. Flyers can be used by institutions, individuals, or businesses to promote 
their products and services. They are a form of mass marketing or small-scale 
community communication.

Business card: A business card is a card that shows business information about 
a company or an individual. It can be shared during formal introductions to help 
a card recipient to easily communicate with the card owner in future.  A business 
card typically includes the bearer’s name, company/institution (usually with a logo), 
qualifications, and contact information such as street addresses, telephone numbers, 
fax numbers, email addresses, and website links.

Postcard: A postcard is a rectangular piece of thick paper or thin cardboard that 
is used to carry a specific message. It is usually used without an envelope.

Book: A book is an extensive publications often with many pages that are bound 
together. It consists of detailed information about a particular subject matter, for 
example the Information and Computer Studies (ICS) book. 

Calendar: A calendar is a system of organising days and specifying different 
events. Calendars can be used to organise events for work, social, religious, 
commercial, or administrative purposes.

Label: A label is a piece of paper, polymer, cloth, metal, or other material affixed 
to a container or an article, on which specific information is printed. Information 
on a label could be about a brand name, product ingredients, contacts, etc.  

Banner: A banner is a form of advertisement that contains a symbol, logo, slogan, 
or other messages to be displayed to a specific audience or public.

Advertisement: An advertisement is a form of communication used to persuade 
an audience (viewers, readers, or listeners) to buy a certain product or service. 
Advertisements relate consumer behaviour with commercial offerings, although 
political and ideological advertisements are also common.

Greeting card: A greeting card is a publication that contains illustration, featuring 
an expression of friendship or other social relationship. Usually, a greeting card 
can be folded and enclosed in an envelope. Although greeting cards are usually 
given on special occasions such as birthdays and holidays, they can also be sent 
to express gratitude or other feelings.

Invitation card: An invitation card is a publication that is used to express an 
invitation to a special event such as a wedding, cocktail, or graduation ceremony 
Figure 3.1 shows examples of different types of publication.  
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Figure 3.1: Examples of different types of publication

Common features of DTP Software
DTP software contain a variety of features which allow publications to appear 
in different styles and colours. A good DTP software also contains ClipArt for 
designing artworks. Other features include facilities to organise text into columns, 
while specifying appropriate spacing for characters, words, graphics, sentences 
and even paragraphs. Some common features for DTP software are described in 
Table 3.1. 

Table 3.1: Common features of DTP software 
No Feature Description

1. Various Project 
Types 

All DTP software can create a variety of projects. In 
other words, they allow flexibility depending on what 
a user needs

2. Layout Tools 
These tools help a user to plan and design a publication 
on a page  

3. Text Tools
Text manipulation tools help to transform text to get 
different artistic effects

4. Graphics Tools Graphics tools help to produce publications with 
high-quality graphic content

5 Printing and 
sharing 

DTP software allows printing to produce hard copy 
and sharing of a document in various ways, such as 
online sharing via e-mails and cloud storage
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Importance of DTP Software
DTP software make publications look good; they also enhance visual 
communication, and streamline dissemination of information of all kinds. 
DTP make it possible to quickly and efficiently produce printed and electronic 
documents. The following are  some of the advantages of DTP software.

(i)	 They are useful for preparing various kinds of publication.

(ii)	 They are good at preparing attractive materials (e.g., teaching/learning, 
advertisements, and invitations) that contain graphical features such as 
pictures, colours, and layouts.

(iii)	 They facilitate sharing of publication materials via physical and electronic 
channels. 

(iv)	 When used for commercial purposes, they are a source of income for 
small, medium, and large entrepreneurs. 

Exercise 	 3.1 

1.	 Define DTP and describe its importance in your school.

2.	 Use examples to explain common publications that can be used in schools 
and businesses.

3.	 Describe four commonly used DTP software.

4.	 Why do people prefer to use a DTP software rather than a word processor 
in designing publications?

5.	 List any four common features of DTP software and explain the importance 
of each.

Working with MS Publisher 2016 
MS Publisher 2016 is a DTP software which is part of the Microsoft Office 2016 
package. It is a powerful software used for DTP purposes. It can be used to create 
high-quality publications on a personal computer by allowing you to manipulate 
features such as page sizes, texts, graphics, layouts, and borders. Learning to use  
MS Publisher 2016 will help you to become familiar with DTP concepts and how 
to apply them in practice. 
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Launching MS Publisher 2016 
There are different ways of launching MS Publisher 2016 on a computer,  depending 
on the operating system and how the computer is configured. A commonly used 
way to start MS Publisher 2016 is by clicking on the MS Publisher 2016 icon on 
the shortcut found on the taskbar or on the desktop. Alternatively, you can use the 
start button to open MS Publisher 2016. Figure 3.2 shows these options. 

Figure 3.2: Options for starting MS Publisher

Key: 	 1 = Start button	 2 = Shortcut for MS Publisher on the taskbar

Activity 3.1 will guide you on how to launch MS Publisher 2016 using the start 
button. 

Activity 3.1: Launching MS Publisher 2016 using the start button

Steps

(i)	 Click on the Start button: icons of different application programs will 
pop up, as shown in Figure 3.3.  

Figure 3.3: Launching MS publisher 2016 using the start button
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(ii)	 Scroll to find the icon for MS Publisher 2016, 

(iii)	 Click on the icon for MS Publisher 2016: MS Publisher 2016 will be 
opened, displaying a window as shown in Figure 3.4.   

Figure 3.4: Default MS Publisher window

(iv)	 Click on the desired template (in this case, Blank A4 (Portrait)): a blank 

MS Publisher file will be opened, as shown in Figure 3.5.

Figure 3.5: A blank MS publisher 2016 file interface
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Parts of the MS Publisher 2016 Window
Like other Microsoft Office applications, the MS Publisher 2016 window 
has several parts, including title bar, menu bar, status bar, and a working area 
(publication area), as shown in Figure 3.6.

 

Figure 3.6: Parts of the MS Publisher 2016

Key: 
1 = Quick access toolbar	 2 = Title bar 
3 = Menu bar	 4 = Sign in command 
5 = Help command 	 6 = Minimize button  
7 = Restore/Maximize button 	 8 = Close button 
9 = Ribbon 	 10 = Page navigation pane 
11 = Vertical & Horizontal rulers 	 12 = Scratch area
13 = Publication area	 14 = Vertical & Horizontal scroll bars 
15 =Status bar 	 16 = View buttons 
17 =Zoom slider 

The items of different tabs, areas, and bars in MS Publisher 2016 are listed in 
Table 3.2. 
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Table 3.2: Items found on different tabs, areas, and bars in MS Publisher 2016

No Features of MS 
Publisher Items contained in a feature

1 Title bar 

Quick access command, name of the program, 
name of the active publication, sign-in icon, help 
command icon, minimise command icon, maximise/
restore command icon, and close command icon

2 Menu bar File, Home, Insert, Page Design, Mailings, Review, 
and View tools

3 Ribbon Contains commands for an active menu tab 

4 Working area Vertical and horizontal rulers, page navigation pane, 
scratch area, and publication page

5 Status bar Status of a document, icons for view and zooming 
slider 

The following are descriptions of some elements of MS Publisher 2016 that are 
used in development of different types of publication. 

File name: Displays the document’s name. If the document is unnamed, the 
name displayed in the title bar will be of the form of “Publication X”, where X is 
the window number.

Quick Access toolbar: It is located at the top left corner of the window. By 
default, it contains icons for New, Save, Undo, and Redo commands.

File menu: Displays the backstage view that contains commands to create, 
open, save, print, and share publications. The backstage view also allows you to 
edit your business information and provides options for other tasks. 

Navigation pane: It allows you to move between different parts of your 
publication, and enables you to add and delete pages.

Publication area: It is an area used for designing publications.

Exploring the menu tabs 
To create a publication, you will mostly use commands from different tabs of 
the menu bar. Clicking on each tab shows a ribbon that contains different groups 
of commands. Table 3.3 lists the different actions that you can perform using 
commands in different tabs of the menu bar. 
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Table 3.3:  Groups and commands found on different tabs on a menu bar

Tab Command Groups 

Home 
Format painter, fonts and font 
formatting, paragraph formatting,
Alignment, style, draw textbox, picture 

Clipboard, Font, 
Paragraph, Styles, 
Objects, Arrange and 
Editing

Insert 

Text boxes, pictures, tables, shapes, 
picture placeholder, page parts, 
calendars, borders and accents, page, 
WordArt, date and time, object, 
hyperlink, bookmark header and 
footer, and page number

Pages, Tables, 
Illustrations, Building 
Blocks, Text, Links, 
and Header & Footer

Page 
Design 

Change template, margins, orientation, 
page size; page set up layout guides; 
apply Schemes; background, and find a 
master pages

Template, Page 
Setup, Layout, Pages, 
Schemes, and Page 
Background

Mailings Mail and mail merge
Start, Write & Insert 
Fields, Preview 
Results, and Finish

Review Check spelling, do online research, 
translate text, and set language Proofing and Language

View Normal/master page view, guides, 
rulers, and graphics manager

Views, Layout, Show, 
Zoom, and Window

Exploring MS Publisher 2016 built-in templates  
MS Publisher 2016 has built-in templates for common types of publication. 
The built-in templates can help you to quickly prepare publications such as 
advertisements, certificates, banners, brochures, business cards, invitation cards, 
envelopes, and flyers. Figure 3.7 shows different publication templates which 
you can customise for different uses. 
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Figure 3.7: MS Publisher 2016 publication templates

Exercise 	 3.2  
Based on your understanding of the features of DTP software you have learnt in 
this chapter, explain how they relate to features in other MS Office applications 
such as MS Word and MS Excel.

Creating a publication
Creating a publication in MS Publisher 2016 is a two-step process. The first step 
is to plan your publication and the second step is to design it.

Planning a publication
Before you start designing any publication, you should plan your work to enable 
you to get better results. The following are some important steps in planning a 
publication.  

1.	 Prepare the content you want to include in your publication (e.g., text, 
image, tables, or graphs). 

2.	 Prepare a blueprint of your publication on a piece of paper. 

3.	 Decide on the colours you will use on your publication. 

Designing a publication
After you have planned your publication, the next step is to design or create it. 
There are two ways of creating a publication in MS Publisher 2016: 
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1.	 Using a blank page (creating from scratch). 
2.	 Using built-in templates.

Creating a publication from scratch
Creating a publication from scratch does not involve reuse of existing templates. 
A designed layout is called a layout guide. The layout guide helps you maintain 
the alignment of objects such as pictures, text boxes, shapes, WordArt, grouped 
objects, and tables. When the layout guide is enabled, it gives you guidance for 
aligning objects on the page. This alignment of objects can be done using edges 
or midlines. Tables can also be aligned using their gridlines. As you drag or resize 
an object on a layout guide, the edges, midlines, and gridlines (in the case of 
a table) will briefly stick to the guide, giving you an indication of the guide’s 
location. The layout guide helps you when setting margins, columns, rows, and 
baseline guides.

Layout organising tools 

There are several tools for organising layout in MS Publisher 2016. The basic 
ones are baselines, boundaries, rulers, guides, page navigation, and scratch 
area, as shown in Figure 3.8. Layout guides are also used to create a grid on a 
master page. In this case, the grids will appear on every page in your publication. 
To navigate to a master page, open the View ribbon and click Master Page: a 
window similar to the one in Figure 3.8 will be displayed. 

Figure 3.8: Publication layout organising tools

ICS FORM 4 COM FINAL .indd   88 13/03/2022   14:13



89

ICS

Key: 

1 = 	 Page Navigation 	 2 = 	 Vertical and horizontal rulers

3 =	 Scratch Area 		  4 = 	 Vertical and horizontal marginal guides

5 = 	 Vertical and horizontal customisable guides	 6 =   Boundaries 

7 = 	 Baselines

The following are descriptions of layout organising tools. 

Baselines: These are evenly spaced horizontal lines that can be used to order a 
text. Activity 3.2 illustrates how to show baselines when designing a publication. 

Activity 3.2: Showing baselines 

(i)	 Click on the View Tab,

(ii)	 Check the box next to “Baselines”: the baselines will be shown. 

Boundaries: A Boundary is a dark blue dashed border that appears around 
objects. Boundaries help in aligning objects and text.

Ruler: A tool that helps in lining up texts, images, and other objects. After 
selecting an object, a blank area will appear on the ruler to indicate the position 
of an object.

Customisable Guide: These are guides used to align objects. There are vertical 
and horizontal customisable guides, both of which are green in colour. The 
procedure in Activity 3.3 will guide you on how to introduce customisable guides 
in designing your publication. 

Activity 3.3: Adding customisable guides in a publication design

(i)	 Click and hold the horizontal or vertical ruler,  

(ii)	 Drag the mouse pointer to the publication, 

(iii)	 Release to add the guide to a particular location: the guide will be placed 
on the publication design. It can be moved at any time by dragging it. 

Margin Guide: Margin guides mark the edges of the printable area, horizontally 
and vertically. A margin is blue in colour and is automatically shown when you 
start the program.
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Page Navigation: This is a pane located on the left of the working area. It shows 
the thumbnails of pages in a publication.

Scratch Area: This is the space outside the page boundary. Anything in the 
scratch area will not be printed when you print the page. Sometimes, a scratch 
area can be used to plan your content before implementing it in the working area. 

NOTE: �Usually, creating a publication is an iterative process. Initially, it involves 
determining the basic form of the document (planning). After planning, 
the design phase involves laying out objects such as text, WordArt, and 
pictures on the page. 

Adding text to a publication 

The procedure in Activity 3.4 guides you in adding text to your publication. 

Activity 3.4: Adding text to a publication

(i)	 Open a new publication, 

(ii)	 Click the Insert tab,

(iii)	 On the Insert ribbon, in the Illustrations group, click the Shapes arrow,

(iv)	 From the pop-up menu, choose the command for inserting a text box,

(v)	 Set the text box by dragging it to an appropriate position, 

(vi)	 Click inside the text box, 

(vii)	 Type some text as shown in Figure 3.9, 

Figure 3.9: Adding text to a publication
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NOTE: �If the text you have typed does not fit in the box, a mark shown by Arrow 
1 in Figure 3.9 will appear. You will be required to either extend the text 
box, or to move the text to a new text box or to a next page. To shift 
the text, point the mouse on the mark fit, and the mark fit will change 
to hand. Click the mark fit, the arrow of a pointing mouse will appear. 
Click on a place you want to insert your text, as shown in Figure 3.10. 
The arrow indicated by 1 shows that the text continues to the next text 
position, and arrow 2 shows the text is preceded by another text. 

Figure 3.10: Transferring text to a new position

Adding objects to a publication

You can insert different objects such as images and drawings into your publication. 
To insert an image to your publication, follow the procedure in Activity 3.5.

Activity 3.5: Adding an image to a publication. 
(i)	 Click where you want to insert an image , for this case, click or place your 

cursor after the text you have typed in Figure 3.10.
(ii)	 Click the Insert tab, 
(iii)	 On the Illustrations group of the Insert ribbon, choose Picture Placeholder: 

an image placeholder will appear on a publication, 
(iv)	 Drag the placeholder to the desired position on a publication,
(v)	 Click on the picture placeholder, 
(vi)	 Select work off-line, 
(vii)	 Browse to find the file that contains your image, 
(viii)	 Select the image, 
(ix)	 Click Insert,  
(x)	 Make necessary adjustments, e.g., resizing. An image will appear as 

shown in Figure 3.11.
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Figure 3.11: A picture inserted in MS Publisher 2016 publication

Formatting text and other objects
Formatting a publication involves specifying how it should appear on a computer 
screen and when it is printed.

Formatting a text
Formatting text in your publication can be done in different ways such as 
changing its direction, size, and colour; and applying attributes like bold, italic, 
underline, subscript, and superscript. Other formatting features are found in the 
Alignment group of the Home ribbon: these include alignment of text at different  
positions such as top left, top centre, and top right, centre left, centre, centre right, 
bottom left, bottom centre, and bottom right.  Also, you can format your text into 
columns using WordArt styles. In Activity 3.6, you will learn how to format a 
text into columns. 

Activity 3.6: Formatting a text into two columns 

(i)	 Open an existing publication, or start a new one, and add some text,

(ii)	 Select the text you want to format: a text box will be activated under the 
text box tools tab,

(iii)	  In the Alignment group of the Home ribbon, click the down arrow on the 
column button,

(iv)	 Choose the number of columns you want for your text (in this case, choose 
two columns): the text will appear as in Figure 3.12.
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Figure 3.12: A two-column formatted text

Formatting other objects  

Formatting other objects or graphics in your publication involves several actions 
such as sending a graphic forward, bringing a graphic backwards, and changing 
the style of your graphic or picture. Sending backwards and bringing forward are 
used to change the order in a stack of pictures (e.g., one picture can be placed 
on top of another), while styling is used to change how a picture looks. The 
procedure in Activity 3.7 demonstrates how to change the style of a picture. 

Activity 3.7: Changing the style of a picture

(i)	 Select the picture you want to format: the picture format tab will be 
activated under the picture’s tools ribbon, 

(ii)	 In the Picture Style group, click on the down arrow to explore more styles, 

(iii)	 Choose the style you want.

Using built-in templates
MS Publisher comes with several built-in templates that can be used for common 
kinds of publication such as certificates, advertisements, invitation cards, flyers, 
and brochures. When preparing a publication, it is a good idea to see if there 
is a built-in template that can serve your needs. You can customise an existing 
template to suit your needs. This saves time that could be wasted if you start from 
scratch. Figure 3.13 shows an example of a template for advertisements. 
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Figure 3.13: A template for advertisements

Exercise 	 3.3
Select a template of your choice from the list templates in MS Publisher 2016 and 
use it to design a publication. Share the publication with your  fellow students in 
the class.

Activity 3.8: Creating a secondary school leaving certificate 

The following steps guide you to create a secondary school leaving certificate as 
shown in Figure 3.14. 
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Figure 3.14: A secondary school leaving certificate

(i)	 Open MS Publisher 2016: the backstage view will be opened as shown 
in Figure 3.15.
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Figure 3.15: The backstage view of MS Publisher 2016

(ii)	 Click on the Blank A4 (Portrait) template as indicated in Figure 3.15: the 
layout view of MS Publisher will be opened as shown in Figure 3.16.  

Figure 3.16: A blank template in MS Publisher 2016
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(iii)	 To add a border, click on the Insert tab,  

(iv)	 On the Insert ribbon, in Building Blocks group, click on Borders & 
Accents: a drop-down box with different border styles will appear as 
shown in Figure 3.17. 

Figure 3.17: Borders & Accents in MS Publisher 2016 

(v)	 Click on More Borders and Accents to find more options of border 
styles. Different types of building blocks for borders will appear as shown 
in Figure 3.18. 

Figure 3.18: Different building blocks for borders
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NOTE: �The building blocks for borders are grouped into different categories, 
including bars, boxes, emphasis, frame, and lines. The choice of a block 
depends on preference or official colours of an organisation.   

(vi)	 Double click the block for a border style of your choice to insert it to a 
publication. The block will appear on your publication as shown in Figure 
3.19.

Figure 3.19: MS Publisher 2016 layout view with an added border 

(vii)	 Click the border to select it as shown in Figure 3.20,

Figure 3.20: Selecting an inserted border

(viii)	 Move the block to the topmost corner and replicate it to fill the top part of 
your publication (see Figure 3.21).
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NOTE: �You can either copy a block and paste it to replicate it, or you may use a 
handle to replicate the selected border. 

(ix)	 Copy and paste the block to cover the rest of the top area as in Figure 
3.21. 

Figure 3.21: Replicated border blocks 
(x)	 Once the top part is filled with border as in Figure 3.21, copy and paste 

the block to the bottom part of your publication as shown in Figure 3.22. 

Figure 3.22: Top and bottom boarder block  

(xi)	 To fill boarders on the right and left sides of the template, copy and paste 
the block and rotate it vertically, then move it to the leftmost side (see 
Figure 3.23), 
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Figure 3.23: Border block replicated on the left side

(xii)	 Copy the rotated block, paste it and move it to rightmost side (see Figure 
3.24), 

Figure 3.24: Border blocks replicated to all sides

(xiii)	 To group borders in a single layer, select the border, 
(xiv)	 On the Arrange group of the Home ribbon, click on Group to group the 

border blocks, as shown in Figure 3.25.
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Figure 3.25: Grouping border blocks in a single layer

NOTE: �The Group tool helps you to control the layout of your text, images, and 
objects in the publication design. 

(xv)	 To insert a title of the certificate, click the Insert tab, and then follow the 
steps in Figure 3.26.

Figure 3.26: Adding text and text effects

(xvi)	 After completion of step 3 in Figure 3.26, a dialog box will appear with 
the title ‘Edit WordArt Text’, as shown in Figure 3.27.
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Figure 3.27: Using the edit dialog box to edit text on a blank page 

(xvii)	 Replace the text in the dialog box with ‘UNITED REPUBLIC OF 
TANZANIA’ and then click OK, 

NOTE: You can use the “Font” part on the dialog box to change the font type 
and size of the text. Otherwise, you can resize the text box to fit in the 
box. To insert the title of the certificate, follow the steps in figure 3.28.  

Figure 3.28: Changing the shape of text in MS publisher

(xviii)	 Repeat the steps, indicated in Figure 3.26, then type the following text: 
PRESIDENT’S OFFICE REGIONAL ADMINISTRATION AND 
LOCAL GOVERNMENT 
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(xix)	 Write the required information on the certificate by following the steps 
shown in Figure 3.29. 

Figure 3.29: Adding text on the certificate

(xx)	 Use the procedure in Figure 3.29 to add student details, date, signature, 
and a box for students’ photo, 

(xxi)	 Add the government logo and a student’s photo by following the steps in 
Figure 3.30. 

Figure 3.30: Adding a photo and a logo to the publication
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NOTE: �In Step 3 of Figure 3.30, if you do not remember the file name, you can 
browse the folder with the photo you want, select the photo (Step 4) and 
insert it. 

(xxii)	 Apply a background to your publication by following the steps shown in 
Figure 3.31. 

Figure 3.31: Adding a background to the certificate.

NOTE: �By clicking on More Backgrounds, you will see more background 
options, such as sold fill, gradient fill, picture or texture fill, and pattern 
fill, as shown in Figure 3.32. 

Figure 3.32: Types of background fill for a publication 

ICS FORM 4 COM FINAL .indd   104 13/03/2022   14:13



105

ICS

You can try different fill styles and see how the certificate looks. For example, 
if you choose the picture or texture fill, the certificate will appear as shown in 
Figure 3.33. 

Figure 3.33: The finished secondary school leaving certificate
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Exercise 	 3.4

Use MS Publisher 2016 templates to design a certificate of award to a form four 
best student using a paper size of A4 and a landscape orientation.

Printing a publication 
MS Publisher can be used to print high-quality publications, using desktop 
printers or any other printing facilities. The Print command in MS Publisher 2016 
is in the backstage view, accessible by clicking the File tab. The steps in Activity 
3.9 guide you to print a publication in MS Publisher 2016.

Activity 3.9: Printing a publication 

(i)	 Click on the File tab,

(ii)	 On the backstage view, click Print: the printer setup window will appear 
as shown in Figure 3.34. 

Figure 3.34: Printing a publication

(iii)	 Select the desired printer from the list,

(iv)	 Specify the number of copies, the number of pages, and other desired 
options as shown in Figure 3.34,

NOTE: The selected printer must be set to print on a paper with the size that 
matches the size of your publication. So, you must decide which paper 
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size is appropriate for a publication like a poster, a newsletter, a brochure, 
a magazine, a business card, etc. Once a printer is chosen, the paper size 
should be changed from the default option to A4.

(v)	 Click on the Print icon to print the publication.

Exercise 3.5 
Review Questions

A:	 Matching items
Match the items in List A with corresponding items from List B by writing the 
letter of the correct response in front of the item in List A. 

List A List B
1.	 	Newsletter ___

2.	 Brochure ____

3.	 Flyer ___

4.	 Business card ___

5.	 Postcard ___

6.	 Advertisement ___

7.	 Calendar ___

8.	 Label ___

9.	 Banner ___

10.	 Greeting card ___

11.	 Invitation card ___

(i)	 A type of publication used to persuade the 
audience about a business or service

(ii)	 Can be a piece of cloth bearing a symbol, 
logo, slogan, or other messages intended 
for a particular audience 

(iii)	 A publication expressing friendship or 
relationship, and is given in special events 
such as a birthday or a graduation 

(iv)	 A piece of paper or other material affixed to 
a product container to display information 
such as brand name and ingredients 

(v)	 An extensive publication with many pages 
bound together 

(vi)	 Organise days with events of social, 
religious, commercial, and administrative 
importance

(vii)	 A rectangular piece of thick paper or 
cardboard intended for writing and 
mailing without an envelope 

(viii)	 A publication that intends to bring people 
together for an event or occasion  
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(ix)	 A publication that shows business 
information about a company or an 
individual   

(x)	 A short leaflet with information for 
advertising an organisation, an event, a 
service, or other activities

(xi)	 Periodically shared publication with one 
main topic for its subscribers

(xii)	 A folded leaflet with brief information 
about an institution such as a school

B. 	 True or False questions
Write T for a true statement and F for a false statement.

1.	 Graphics design is the process of typing documents such as letters and 
reports___

2.	 MS Publisher can be a source of income for small scale entrepreneurs, if 
used for business purpose___

3.	 Rulers in MS Publisher help in lining up text, images, and other objects ___

4.	 A ribbon in MS Publisher contains a group of commands from an active 
menu tab ___

5.	 A publication area in MS Publisher enables you to delete and add pages ___

C:	 Short answer questions  
Answer the following questions: 

1.	 (a) 	 What is publishing?
	 (b) 	 What is a desktop publishing software?

2.	 Why are desktop publishing software preferred over a word processor in 
designing publications?

3.	 Give three examples of desktop publishing software available in the market 
today.

4.	 Describe layering and its importance in creating a publication.	

5.	 Describe three main purposes of a desktop publishing software.
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6.	 Describe two ways of designing a publication by using MS Publisher.

7.	 State five features of a desktop publishing software and their uses.

8.	 Discuss the steps you need to follow when planning for a publication.

9.	 Use an example to explain how the knowledge of DTP can help you to 
employ yourself. 

10.	 Design an invitation card to invite students and parents to a form four 
graduation ceremony of your school. 

11.	 Design a brief school newsletter, covering events that happened in the past 
three months. 
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The concept of multimedia

Multimedia is a compound word in which, ‘multi’ means ‘more than one’ and 
‘media’ means the different forms of transmitting information or messages. 
Therefore, literally, multimedia means more than one media. This implies that 
different types of media can simultaneously be used for conveying a message. 
For example, a slide of a presentation delivered by your ICS teacher may contain 
text, images, animation, and video content. Such a presentation can be said to 
have multimedia characteristics. Another example of multimedia is a song in 
YouTube, which might have images and videos that are accompanied with lyrics 
expressed in form of text. Figure 4.1 shows a TV programme that contains both 
animated images and text exemplifying multimedia content.

Figure 4.1: A TV programme that exemplifies  multimedia content

Chapter

Multimedia

04

Introduction
Traditionally, people use content based on a single medium such as video, 
image, animation, text or sound to convey a message from a sender to 
a receiver. However, advancement in technology has enabled the use of 
multimedia to transform the way messages are conveyed, whereby more than 
one medium can be combined to deliver a message. In this chapter, you will 
learn about multimedia concepts; multimedia devices; and how to record 
sound, shoot video, edit and compress  video. The competence developed will 
enable you to prepare multimedia content for different contexts and purposes. 
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Let us consider another multimedia example: when you watch a television 
programme, you can encounter more than one form of presentation of content. 
You can see a video of a person speaking and, at the same time, you can hear 
an accompanying sound. Such an instance involves more than one form of 
communication, and you can say that television programmes provide us with 
multimedia-based communication. The ability to see images, hear sound, and 
read text on a television or video playback exemplifies multimedia presentation. 

History of multimedia
Historically, multimedia is believed to have begun with newspapers. Newspapers 
were the first communication medium to combine text, images, and graphics 
to communicate information to an audience. Later, television became a new 
multimedia communication platform. This platform delivers content in multiple 
forms such as text, audio, and images. Unlike newspapers which present 
information in static forms, television programmes display information that is in 
motion. Currently, multimedia content delivery has become more dominant due 
to the development of the World Wide Web (WWW) and computers. Multimedia 
has developed as an area of study which combines many technologies to produce 
various forms of content to facilitate communication. Also, handheld devices such 
as smartphones and tablets have promoted easy access and use of multimedia 
content.

Types of multimedia content
Multimedia content can be linear or non-linear. Linear multimedia content, also 
known as passive multimedia, proceed without user interaction. Examples of linear 
multimedia content can be found in a cinema presentation or when watching a TV 
programme. In non-linear multimedia content (also known as active multimedia), 
user interaction is required for the content to proceed. Examples of non-linear 
multimedia content can be found in computer games, where you must perform a 
task for a game to continue. Also, computer-based training, in which learners learn 
at their own pace, is an example of non-linear multimedia content. It is possible 
to have live multimedia presentations or recorded multimedia presentations, in 
which a navigation system allows user interaction. Imagine receiving a WhatsApp 
message from your friend which informs you about a birthday party invitation. 
The message contains texts and a link at the end. Clicking the link opens an image 
of the invitation card. This card can also contain a melody. All this demonstrates the 
notion of non-linear multimedia.

ICS FORM 4 COM FINAL .indd   111 13/03/2022   14:13



112

ICS

Exercise            4.1

1.	 What do you understand about the concept of multimedia? 

2.	 Use an example to differentiate between linear and non-linear 
multimedia content.

3.	 Discuss how handheld devices such as smartphones have transformed 
the use of multimedia.

Multimedia devices
A multimedia device is an electronic appliance used to record, store, produce, 
display or playback multimedia content. Hardware and software are important 
parts of multimedia devices. The hardware stores, processes, and displays 
multimedia content, while the software facilitates recording, editing, storing 
and retrieving of multimedia content from the storage devices. Examples of 
multimedia devices are multimedia projectors, smartphones, tablets, iPads, 
desktop computers, laptops, video game consoles, and video cameras. Some of 
these devices are described next.

Multimedia projector: This is an output device used to display multimedia 
content on a projector screen or a wall. It can display text, images, and video on 
a screen. Figure 4.2 shows an example of a multimedia projector.

Figure 4.2: An example of a multimedia projector
Smartphone: This is a multimedia device that can send and receive text messages, 
make and receive calls, as well as process and share multimedia content. A 
smartphone can be used to record both videos and images. It can be used to play a 
video and display an image that has been recorded. It is also capable of recording 
and playing sound. Figure 4.3 shows an example of a smartphone.
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Figure 4.3: Rear and front view of a smartphone

Computer: This device can be used to prepare multimedia content. A computer 
processes text, audio, animation, graphics, and video to form a digital representation 
of information. It also stores and displays multimedia content and transmits it from 
one user to another over a network. Using a computer, you can interactively run 
multimedia content such as e-learning materials. Figure 4.4 shows an example of 
a computer displaying multimedia content.

Figure 4.4: A laptop displaying multimedia content

Video game console: This is a multimedia device used to play video games. 
While playing a video game, you interact with the console by navigating across 
the game graphics. The device must be connected to a TV screen to display game 
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graphics and play the game. An example of a video game console is shown in 
Figure 4.5.

Figure 4.5: An example of a video game console
Digital camera: This is a multimedia device used to capture video, audio and 
images. Digital cameras are of different sizes and types and are used for different 
contexts. The nature of a video you want to make will determine an appropriate 
camera and type of lens for your purpose. Figure 4.6 shows examples of digital 
cameras.

Figure 4.6: Front, rear and side view of a digital camera

Drone camera: A drone is an Unmanned Aerial Vehicle (UAV) that can be 
remotely controlled. A drone camera is a type of a camera that is attached to a 
drone and used for recording videos and taking pictures. Drone Cameras come 
in a variety of sizes, the largest of which is used for military purposes known as 
military or predator drones. Drone cameras can also be used to record videos 
and images of various events such as weddings, political gatherings, sports, and 
games. Drone technology is constantly evolving through innovation and large-
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scale investment, causing advanced drones to be introduced to the market every 
few months. Figure 4.7 shows examples of drone cameras.

Figure 4.7: Examples of drone cameras

Wearable digital devices: These are multimedia devices that are worn close to 
and/or on the skin, and are used to detect, analyse, and transmit information of 
concern. Examples of wearable devices are smart watches, fitness trackers, and smart 
clothes. These devices can send messages, make calls, and display an image and/
or even a video. Figure 4.8 shows examples of wearable digital devices.

Figure 4.8: Examples of wearable digital watch and a smart cloth

Multimedia system
A combination of multimedia devices form a multimedia system. A multimedia 
system is a system capable of processing multimedia data, including generation, 
representation, recording, storing, transmission, searching, retrieval, and delivery 
of multimedia information. Specifically, multimedia systems are computer 
hardware, software, as well as tools and devices that support the combination 
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of text, images, graphics, animations, audio, or video, and which can be used in 
production of content.

Activity 4.1: Exploring multimedia devices

Suppose you are required to display a video showing the surroundings of your 
school. Conduct an online search to find out all devices that will help you to 
record, edit and display the video. 

Characteristics of Multimedia Systems
Multimedia systems have the following characteristics:

(i)	 They are computer-controlled.

(ii)	 They integrate and process more than one form of information.

(iii)	 They handle information that is represented digitally.

(iv)	 The interface that presents multimedia content is usually interactive.

 For multimedia systems to work effectively, the following aspects are important:

High Processing Power: This processing power is required to deal with high 
speed data processing and real time delivery of multimedia content. Because 
multimedia content involve more than one media element, including high-
resolution graphics and high quality video, faster processors are required for 
better performance.

Multimedia Capable File formats: This file format is required to deliver real- 
time media, e.g., Rich Text Format (RTF) for text, or Joint Photographic Expert 
Group (JPEG) for images, or Motion Picture Expert Group 4 (MPEG/MP4) for 
videos.

Efficient and Fast Input/Output (I/O): The input and output to/from the file 
subsystem needs to be efficient and fast since Multimedia systems allow real-
time recording as well as playback of data.

Large Storage and Memory capacity: Large storage and memory capacity are 
required for efficient management of multimedia content. Because multimedia 
involves graphics of high resolution and high-quality video and sound, it requires 
large amount of storage space. 

Reliable Network Support: If delivery is via network or Internet involving 
client-server systems, a reliable network is required to share, retrieve, and display 
multimedia content.
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Software (Application or System): Software are needed to access, retrieve, share 
or display multimedia content.

Categories of multimedia system devices
Multimedia devices can be grouped into three categories: input, output, and 
storage devices.

Input devices
The following are examples of multimedia input devices.

(i)	 Keyboard: used to input a text for multimedia content.

(ii)	 Digital cameras, scanners and CD-R/DVD-R: used to store and 
playback audio, video and images of multimedia content.

(iii)	 Musical Instrument Digital Interface (MIDI) based keyboard, CD 
and Microphones: used to capture and playback audio of multimedia 
content.

(iv)	 Mice, track balls, joy sticks, and light pens: used for spatial data 
input.

(v)	 Modem and network interfaces card: used for network data input.

Output devices
The following are examples of multimedia output devices.

(i)	 Computer Monitor for displaying video, images, text and motion 
graphics.

(ii)	 Projector: for displaying text, graphics, and videos.

(iii)	 TV Screen: for displaying multimedia content.

(iv)	 Smartphone display screen: for displaying multimedia content.

(v)	 Colour printers: for printing multimedia content.

(vi)	 Speaker or any other MIDI interfaces for producing sound.

Storage devices
Common storage devices for multimedia content include the following.

(i)	 Hard disk drive e.g., Serial Advanced Technology Attachment 
(SATA) or Solid State Drive (SSD)

(ii)	 CD-Rs/ DVDRs

(iii)	 Flash disk/USB Memory Stick 

(iv)	 Memory Card, e.g., Secure Digital (SD) Cards or Micro SD Cards
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Use of Multimedia
There are several uses of multimedia in our daily lives. The most common uses 
include entertainment, advertisement, education, and medicine.

Entertainment: Multimedia is extensively used in the entertainment industry, 
especially in the music, movies, and animations industry. Multimedia content 
aim to engage users in expressing music, movies, games or a variety of videos in 
a more entertaining way than traditional entertainment media or arts. Therefore, 
multimedia content facilitate positive and active users participation and 
interactiveness. Figure 4.9 shows children interacting with multimedia content. 

Figure 4.9: Children interacting with multimedia contents 

Advertisement: Multimedia technology is used to produce an exciting presentation 
that can grab and keep the attention of the audience on an advertisement. For 
example, the advertisements you watch on television billboards along the roads 
and on social media may contain texts, images, videos and graphics combined to 
communicate information about a product or a service that is being advertised.

Education: Multimedia technology is very popular in education. It is used to 
produce computer-based courses that include videos, graphics, and sound, 
which aid in understanding course materials. Multimedia devices are also used in 
designing and disseminating interactive content for learning.

Medicine: The use of multimedia in medicine has many advantages, including 
creating awareness to patients about health issues using various media types. 
Hospitals can provide content in video, sound or graphics to patients to explain 
medical issues such as how to prevent various diseases or how doctors perform 
medical procedures. Such information, which can be presented through a 
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combination of image, videos and animations, helps patients to better understand 
their medical issues. Currently, multimedia application software such as 
e-Anatomy or Genome enable doctors to perform virtual surgery. This increases 
capacity to provide a medical service, including remote provision of surgery 
services in hospitals remotely. Likewise, using multimedia, the doctor can 
simulate the spread of new diseases such as Covid-19, and that, can contribute to 
the development of means to prevent and combat the disease.

Audio and video
Audio and video are among technologies used to carry multimedia content. For 
example, a multimedia content displayed on a TV programme combines media; 
apart from image, text, and animations, it contains video and audio. But there are 
some cases where you can have a video that shows only images without sound, 
or sometimes you can mute the sound and watch the video. 

Concept of Sound and Audio

Sound is a form of energy produced by vibrating molecules of a substance. When 
an object is hit, its molecules vibrate, causing variations in the pressure of the air 
around it. This vibrating air is heard and interpreted by an ear as sound waves. 
For example, when you beat a drum, you produce a sound that can be heard by 
your ear. Human beings creates voices which are sound waves produced by a 
vocal cord vibration. This sound can be recorded, processed, and transmitted 
using a microphone. In multimedia, the transmitted, recorded, or stored sound in 

1.	 Using a computer or a mobile phone, play any computer game found 
in it and then answer the following questions.
(a)	 Does it qualify to be a multimedia video game? Justify your 

answer.

(b)	 If you were to correct anything in the game you have played, 
what would you correct and why?

2.	 Discuss other areas, apart from those explained in this book, where 
multimedia technologies play a role in your society.

Exercise	 4.2
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digital form is referred to as audio. If you use a multimedia device to play an audio 
file, you will hear a sound. This is because the electrical energy in the audio file 
will be converted back to sound energy using a speaker.

Sound/Audio recording equipment for multimedia production
There are several equipment you can use to produce audio for use in multimedia 
production. The required equipment include microphones, computers, sound 
cards, sound editing software, and other accessories such as cables and pop 
filters. A microphone is a device that transforms sound energy to audio signal/
energy (mechanical to electrical energy). Microphones can be categorised based 
on their sound pick up pattern characteristics. There are three types of microphone 
based on how they pick up sound. These are unidirectional, bi-directional, and 
omnidirectional microphones. A unidirectional microphone (Figure 4.10) captures 
sound from one direction only and picks up sound from the top of a microphone. 
It is suitable for recording sound from a single person, like in speeches.

Figure 4.10: Unidirectional microphones

Bi-directional microphones (Figure 4.11) record sound from two directions or 
sides of the microphone, mostly front and back. These types of microphone are 
mostly used during question and answer sessions or interviews that involve two 
people. 

Figure 4.11: Bi-directional microphones
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An omnidirectional microphone (Figure 4.12) is a microphone that records sound 
from all directions. It is suitable for a group conversation, live performances of 
plays and musicals, TV and radio broadcasting, and studio recording of music.

Figure 4.12: Omnidirectional microphones

Some computers, especially laptops, have a built-in microphone that you can use for 
audio recording purposes. Such a computer has a sound card, which is an electronic 
device that converts   an analog sound signal into a digital audio. Sound cards can 
be internal (Figure 4.13(a)) or external (Figure 4.13(b)). An internal sound card 
is slotted inside a computer, while an external sound card connects to a computer 
through a USB or Firewire cable.

Figure 4.13(a): Internal sound card                Figure 4.13(b): External sound card

In digital sound recording, a software controls the whole recording process. After 
connecting the hardware for sound recording, you can command the recording 
process through a software interface. There are software packages that are used 
for sound production, including Audacity, Power Sound Editor, Adobe Audition, 
Ardour and Traverso DAW. Some of these software are open source (e.g., 
Audacity), and some are proprietary (e.g., Adobe Audition). Examples provided 
in this book are based on Audacity. Audacity is a multi-track recording software 
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that you can use to record and edit audio. It is downloadable in a portable format 
(zipped), and so you just need to unzip and install the software. Audacity can be 
downloaded from http://www. audacityteam.org/download.

Audio recording
Recording audio for multimedia use involves several steps. In this section, you 
will be guided through the steps required to accomplish this task using Audacity.  

Step1: Download and install Audacity from the following link: http://www.
audacityteam.org/download. Activity 4.2 guides you on how to download 
Audacity software.

Step 2: Connect a microphone to the sound card by choosing an appropriate 
symbol of a microphone port as shown in Figure 4.14.

Figure 4.14: Examples of microphone connection ports found on computer hardware
 
Step 3: Start the Audacity software: You will be presented with an interface like 
the one in Figure 4.15.

Activity 4.2: Downloading Audacity software
(i)	 Type the Audacity download link in the address bar of your browser, and 
then press Enter key

(ii)	 Click on the button for Audacity for Window,

(iii)	 Follow the instructions provided to install the program.

Microphone             Line-in                Line-out

ICS FORM 4 COM FINAL .indd   122 13/03/2022   14:13



123

ICS

Figure 4.15: Default interface of Audacity software

NOTE: Because Audacity is a multi- track recorder, you are presented with the 
work area which does not have any track. 

Step 4: Add an audio track: When you start recording, audio tracks are added 
automatically to the workspace. However, for editing purpose, you may add 
tracks manually to the workspace. Activity 4.3 guides you to add a track manually 
to the workspace.

Activity 4.3: Adding a track manually to the workspace 

(i)	 On the main menu, click Tracks,

(ii)	 Select Add new,

(iii)	 Click Stereo Track as shown in Figure 4.16. The track will be added 
to the Audacity program workspace, as shown in Figure 4.17.
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Figure 4.16: Adding a track manually to Audacity workspace 

 
Figure 4.17: Visual presentation of tracks on the Audacity workspace 

Part of the Audacity interface is a transport tool shown in Figure 4.18. The 
transport tool is represented by six buttons: pause (blue), play (green), stop 
(brown), skip to start(purple), skip to the end (purple), and record (red).

Figure 4.18: Audacity transport tool

Step 5: Start a recording session: You need to uncheck ‘Playthrough and 
Overdub’ before recording to avoid voiceover. Uncheck Playthrough to avoid 
interference from the speaker, which can lower the quality of your recording. 
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Uncheck Overdub to prevent playing of the previously recorded tracks when you 
are recording a new one.

The procedure in Activity 4.4 guides you to disable Playthrough and Overdub  
in Audacity.

Figure 4.19: Disabling overdub and software playthrough

NOTE: This can also be done by following the path Edit->Preferences-

>Recording (Figure 4.20), that enables you to disable Overdub, Software 
Playthrough, and Sound Activated Recording.

Activity 4.4: Disabling Playthrough and Overdub in Audacity

(i)	 Click on the Transport tab,

(ii)	 Select Transport Options,

(iii)	 Click on Software Playthrough to uncheck it,

(iv)	 Click on Overdub to uncheck it, as shown in Figure 4.19.
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Figure 4.20: Disabling overdub, software playthrough and sound activated recording

You must also take care of a sound-activated recording, which, when activated, 
recording will start automatically, based on a chosen volume threshold. You can 
monitor the audio levels by turning on the monitor. Click Start Monitoring, 
accessible through the microphone icon (Figure 4.21(a)), and then you will see  a 
meter showing the sound level (Figure 4.21(b)).

	

When you talk on the microphone, you will see the sound level changing on the 
sound level meter. If the sound level is too high, you can adjust it using the sound 
level adjustment slider, as shown in Figure 4.22.

Figure 4.21(a): Starting audio levels 
monitor

Figure 4.21(b): Audio levels
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Figure 4.22: Microphone and speaker volume adjustment sliders

To record the sound of interest, click on Transport->Recording->Record, then 
talk to the microphone. Once you finish talking, click the Stop button. An audio 
track will automatically be added to the workspace, and the recorded sound 
waves will be visible on the track (see Figure 4.23). You can also see the sound 
level meter that indicates recorded audio levels.

Figure 4.23: Audacity interface showing recorded sound on a 
track

Step 6: Save the recorded audio clip
 
After you have recorded an audio clip, you may save it for future use or further 
processing. To save the project, click the File tab and select Save Project as 
shown in Figure 4.24. A new page will pop-up, requiring you to name your 
project. Provide a name for your project, and it will be saved as an Audacity 
project file, not an audio file.
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Figure 4.24: Saving an Audacity project

Step 7: Export the audio clip to an audio storage in a file format such as Wave 
form Audio File (WAV). This will enable the recorded audio clip to be used in 
other software products. To export an audio clip to the WAV format, click Export 
, on the File tab: the Export Audio dialog box like the one shown in Figure 4.25 
will appear.

Figure 4.25: Dialog box for exporting an audio file

Select WAV in the Save as type, name the file, and then click Save. You can now play 
and hear your voice using any audio player.

NOTE: To export an audio clip in MP3 format, you may be required to download 
and install a special library for encoding your audio in  MP3 format.
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Digital Audio Editing
Audio editing involves the removal of unwanted parts of an audio clip; splitting or 
joining audio clips; changing some audio clip characteristics such as gain, volume, 
or speed; inserting audio clips; and mixing audio clips. In Audacity, audio clips 
are arranged in tracks. Each audio track has its control panel, as shown in Figure 
4.26.

Figure 4.26: Audacity audio track control panel and associated 
features

You can open as many tracks as required for your audio editing. To close the 
track, click the close button (X) on the left corner of the track drop-down menu. 
To edit audio clips in Audacity, follow these steps.

Step 1: Import an audio clip you want to edit: To import an audio clip, click the 
File menu and then select Import (see Fig 4.27).

Figure 4.27: Importing an audio clip in Audacity
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Step 2: Perform the editing of your interest: There are several tools that can help 
you to manipulate an audio clip. These tools are located on the menu bar for easy 
access (see Figure 4.28).

Figure 4.28: Quick audio editing tools in Audacity

Using the select tool (circled yellow in Figure 4.29(a)), select half of your audio 
clip (Figure 4.29(a)).

Figure 4.29(a): Selecting portions of an audio clip
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Press Delete to remove the selected part, and the remaining part will appear as 
shown in Figure 4.29(b).

Figure 4.29(b): The remaining audio clip after deleting a selected 
part of the audio

You can also split the recorded audio into two parts using the boundary split tool 
(see Figure 4.30(a)).

Figure 4.30(a): Boundary splitting of a clip
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The two resulting clips can be separated using the shift tool (see Figure 4.30(b)), 
leaving a gap between the separated clips.

Figure 4.30(b): Separating the clips apart using the shift tool

To insert a sound clip on the gap, first import the clip you want to insert (see 
Figure 4.31(a)).

Figure 4.31(a): Imported sound clip

Then move the clip from the second track to the gap on the first track (Figure 
4.31(b)) using the shift tool.
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Figure 4.31(b): Audio clip moved to fill the created gap

You can add background music by simply importing music and adjusting the 
volume (See Figure 4.31(c))

Figure 4.31(c):  Volume adjustments for imported music
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Video
A video is a visual medium in which a sequence of images is combined to produce 
moving pictures. Videos are usually accompanied with audio parts that describe 
what is displayed.

Video recording
Video recording or shooting refers to the process of recording pictures for 
producing moving images or video. Two steps are followed in video recording: 
First is planning for video production, which includes writing a script (content) 
for video shooting. This step is well known as a pre-production stage. The second 
step is the production stage, whereby the actual video recording takes place. 
Lighting for video is an essential aspect during video recording. The source of 
light can be natural or artificial. Special skills, techniques, and equipment (see 
Figure 4.32) are also needed for someone to shoot a good video. Some important 
video recording techniques focus on how to record videos, sound, lighting a 
scene, framing of shots and organizing the final video sequences. 

Figure 4.32: Examples of video production equipment
You probably already know many video production terms, just by watching 
television. These may include how long each shot lasts, how often the camera 
moves, and how shots are edited and sequenced. You may also try to focus your 
attention on the visuals alone without the audio, by analysing the shots, and you 
will discover a sequence that provides basic building blocks in the edited footage.

Write down your brief history from birth up to now, explaining, among 
other things, how you spend your school holidays. Using Audacity, record 
a sound that narrates your history and export it to WAV format.

Exercise 	 4.3 
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Parts of a Video Camera

The most important device in video production is a video camera. A video camera 
is a camera used to record motion pictures. Video cameras are used primarily in 
two modes. The first, characteristic of old broadcasting, is live television, where 
the camera feeds real time images directly to a screen for immediate view. In the 
second mode, the images are recorded to a camera storage device for archiving 
or further processing. 

To use a video camera, one needs to understand its basic and operational features. 
Figure 4:33 shows the basic parts of a camera. 

Zoom ring

Focus ring

Distance scale

Neckstrap lug

Mode dial
Flash hot shoe

Viewfinder eyepiece
Monochrome LCD control panel

Neckstrap lug

Main command dial

Shutter release

Control buttons

Lens

Camera body

Figure 4.33: Basic parts of video camera

Camera support mechanism 
Camera support mechanism is about enabling the camera to capture images (in 
motion) that imitates what we see in reality. Effective video recording starts with 
a camera person appreciating the importance of the camera support to the whole 
process of shooting. The tool that help to support the camera is a tripod. 

Tripod 
Using a tripod is the standard method of supporting a camera. A tripod has three 
legs that are collapsible and individually adjustable in length to provide a solid, 
level support for the tripod head. The tripod provide a system of moving the 
camera right and left on the horizontal plane (pan) and up and down (tilt). Tripods 
have a built-in levelling bubble to enable the camera person to get the precise 
levelling. Figure 4.34 shows operational parts of a tripod. 
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Ball head

Center column

Twist leg locks

Multi-angle
Leg locks

Tripod feet

Retractable counter weight hook

Center column twist lock

Quick-release plate

Figure 4.34: Operational parts of a tripod

Shots, Scenes, and Sequences
These are building blocks of the final edited footage of a video, which is also 
called a film/movie or TV programme. If you watch television or movies, you 
will see that, in general, there is not much movement of a camera. Instead, a series 
of individual static shots are put together to form scenes and sequences. A shot is 
a continuous view filmed by one camera without interruption. The number of 
frames you shoot between activating and deactivating the record button on your 
camera constitutes a shot. A frame is a basic unit of a shot, while shot is a basic 
unit of video, TV programme or film.  Figure 4.35 shows the building blocks of 
the final edited footage. 

                                   

Figure 4.35: Building blocks of the final edited footage of a video
Let us compare a book to a film, Video or TV programme to understand how 
frames, shots, scenes and sequences works to complete a film, Video or TV 
programme. Sentences have words; assume that each word is a frame. A series 
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of words (frames) forms a sentence (shot). A series of sentences (shots) forms 
a paragraph (scene). A series of paragraphs (scene) forms a chapter (sequence). 
A series of chapters (sequences) constitutes a book (the video, film or TV 
programme). Therefore, scenes and sequences are made up of a variety of shots 
available to a videographer. The list of shots could be quite long. In general, the 
list of shots can be put into seven basic types, based on their sizes as follows

1.	 Extreme Long Shot (XLS)

2.	 Long Shot (LS)

3.	 Medium Long Shot (MLS), also known as Knee Shot

4.	 Medium Shot (MS)

5.	 Medium Close Up Shot (MCU)

6.	 Close Up (CU)

7.	 Extreme Close Up Shot (XCU)

Extreme Long Shot
An extreme long shot, also known as Extreme Wide Shot (EWS), is a shot that 
covers a wider area. The shot frames the subject from a distance and emphasizes 
on an environment where the subject is found. This type of shot is mostly used 
to establish the setting or location where an event or action occurs. Figure 4.36 
shows an example of an Extreme Long Shot. 

Figure 4.36: Example of Extreme Long Shot
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Long Shots
An long shot captures the entire subject from head to toe. It is also known as a full 
shot and is useful when you want to focus on the subject while at the same time 
showing the surroundings or background scenery the subject is in. Figure 4.37 
shows an example of a long shot.

Figure 4.37: Long Shot

Medium Long Shot 
A medium long shot, also known as Knee Shot, is a shot that frames the subject 
from the knee to the head. It is a type of shot found between a long shot and a 
medium shot. This type of shot is used to capture emotions expressed through a 
body language, showing multiple subjects occupying one scene and in establishing 
the environment the character is in. Figure 4.38 shows an example of a medium 
long shot.

Figure 4.38: Medium Long Shot
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Medium Shot 
A medium shot, also known as Mid Shot, is a shot that frames a subject from the 
waist to the head. It is useful when you want to show the subjects performance, 
especially actors or actresses, and the surroundings they are in. This type of shot 
is also useful when you want to emphasize on the actions, costumes and properties 
worn or used by an actor or actress. Figure 4.39 shows an example of medium shot.

Figure 4.39: Medium Shot

Medium Close Up Shot
A medium close up shot, is a shot that shows the subjects from the head to a point 
just below their chest. This type of shot is framed midway between medium shot 
and close up shot. It is tighter than medium shot and wider that close up shot. 
This type of shot captures the emotions as well as facial expressions of a subject 
or performer while giving an audience enough information to understand where 
the  subject is located. Figure 4.40 shows an example of a medium close up shot.

Figure 4.40: Medium Close Up Shot
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Close Up
Sometimes, an image may appear to be very close, and sometimes, it may appear 
to be far. An image that appears to be close is a good example of a close-up shot. 
In a close-up shot, objects appear to be magnified. A viewer is provided with 
small and greater details of the action taking place on the scene and can easily 
understand the emotional reactions of the subject, which are expressed through 
facial expressions in a scene. For example, a close-up shot of a person giving a 
speech would put more emphasis on his or her emotions. Figure 4.41 shows an 
example of close up shot.

Figure 4.41: Close Up Shot

Extreme Close Up Shot
An extreme close up shot is a shot that shows only the subject’s face, eyes or 
any other specific aspect of a subject. Extreme Close Up shot is mostly used to 
express and emphasize the significant minute details of emotions of a subject. 
It is useful in capturing the mood or tone of the scene. Figure 4.42 shows an 
example of an extreme close up shot.

Figure 4.42: Extreme Close Up Shot
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Framing a shot
When you shoot a shot, the object need to be placed in such a way that either 
attention is paid to them, or they share the scene with something or someone else. 
An effective shot is framed and composed. Framing is the process of selecting a 
part of a view that you want to isolate and emphasize. Therefore, framing means 
selecting exactly what the viewer is going to see and what the content and volume 
of your screen will be.

Principles of framing a shot
1. Determine the headroom, talking room and walking room: Headroom is a 
distance between the top of the subject’s head and the edge of the frame. The 
headroom for shots made for film and drama is different from the headroom for 
shots made for TV. While too little or no headroom gives a constricted feeling, 
too much headroom can result in an odd image. Figure 4:43 shows the position 
of headroom.

Figure 4:43: Headroom
A talking room, also known as Nose Room or Looking Room,  is an area between 
the side of the frame and the face of the subject looking to one side. If a person 
is talking to another person on camera, this is shown as space between them. 
We assume this creates an area of interest outside the screen area and helps the 
viewer to connect to the part outside the frame-interest-area. Figure 4:44 shows 
the position of Looking Room.

Headroom
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Figure 4:44: Looking Room
Walking Room/Leading Room is the area that is left in the shot about the action 
of walking. Figure 4.45 shows the Walking Room.

Figure 4:45: Walking Room

2.	 Find and use the natural lines: Use the vertical and horizontal natural lines 
to level/balance your picture. Look for horizontal and vertical lines in the 
frame (e.g., the horizon, poles, etc.). Make sure that horizontal lines are 
aligned well with the right and left edges of your frame. They should be 
aligned with the down and top edges of the frame and the vertical lines un-
less you are purposely going for a tilted effect.

3.    �The subject at the centre: Place the most important things at the centre of the 
screen. The smaller the picture on the screen, the lesser the effect. Maintain 
stable/steady pictures; stable pictures cater for the psychic and eyes of a 
human being. 

Looking Room

Head Room

Subject’s 
eyes are 
focal 
point

Walking Room
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Rules of framing a shot
It is important to pay attention to the rules of framing, when you are shooting a 
video. One of the basic rules of framing is the Rule of Thirds.

Rule of Thirds
A basic rule of framing is the rule of thirds (see Figure 4.46 and Figure 4.47). This 
rule gives you an idea of where to place your subject within a frame. Though you 
may be inclined to position a subject at the centre of the screen, applying the rule 
of thirds will give you a more compelling picture. First, imagine that two vertical 
and two horizontal lines divide your view finder into thirds. The rule of thirds 
suggests that the main subject in your shot should fall on one of the points where 
these imaginary lines intersect. The resulting image will be more compelling than 
if you simply place your subject in the cross hairs.

Figure 4.46: Place your subject on any of the two points where the lines  intersect  
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Figure 4.47: A short framed using the rule of thirds

When shooting a person using a camera, that person’s eyes are your main focal 
point. Whether using a wide shot or a close up, compose the shot so that the person’s 
eyes fall on one of the uppermost imaginary intersections. The intersection you 
choose does not make affect to the position and direction of where a person is 
looking. Whether someone is looking from the left or right third of the screen, the 
frame should always point on the eyes for better result. However, this places the 
subject slightly off centre and brings in another principle of composition called 
looking or talking room (Figure 4.48) as described before.

Figure 4.48: The looking room in relation to the rule of third
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Points (or lines) of interest occur around 1/3 or 2/3 of the way up (or across) the 
frame, rather than at the centre. Like many rules of framing, this is not always 
necessary (or desirable), but it is one of those rules you should understand well 
before you break it.

In most “people shots”, the main line of interest is the line going through the 
eyes. In this shot, the eyes are placed approximately 1/3 of the way down the 
frame. Depending on the type of shot, it is not always possible to place the eyes 
like this and the sky takes up the rest. This could be a “weather shot”, in which 
the subject is the sky.

Leading room/walking room in relation to Rule of Third
As stated previously, it is important to leave a space between someone’s face and 
the screen, but, equally important, when shooting or moving animation like in a 
moving cartoon, a space should be left between a moving subject and the screen. 
The space left between the moving subjects and the screen is called Leading 
Room or Walking Room.  Figure 4.49 shows the leading room in relation to the 
Rule of thirds.

Figure 4.49: Leading room in relation to the Rule of Thirds
Generally, allow extra space in front of a moving cartoon so that the viewer 
can see that it has some place to go. Without this visual padding, the cartoon’s 
forward progress will seem impeded.

ICS FORM 4 COM FINAL .indd   145 13/03/2022   14:13



146

ICS

Backgrounds
Many pitfalls of composition lie in the subject’s environment. Trees and phone 
poles, as well as pictures on walls may all cause problems. Be aware of 
lampposts, trees or other such objects that are directly behind your subject. A 
flagpole protruding from the top of an actor’s head looks ridiculous, as does 
a vase that may seem to be balanced on someone’s shoulder. Likewise, a power 
line running through the frame may appear to be going in one of your subject’s 
ears and out of the other. It is best to avoid any such visual distractions. Even if 
these objects are not directly behind your subject, they can still cause problems. A 
lamppost running vertically through the middle of the frame will not only disrupt 
the balance achieved by the rule of thirds, it will  also isolate or box in the subject. 
Camera angles 

A camera angle is the level from which you look at the subject through the 
camera. It describes the position/height from which the audience will be looking 
at the objects or subjects.

Types of Camera Angle

There are four types of cameras angles: high angle, eye-level angle, low angle  
and bird eye-view angle. 

High Angle: A high angle also called upshot, is when a camera is placed 45  degree 
above the subject’s head. The camera looks down on the subject. The subject 
becomes  like inferior, helpless, and defeated. It gives the audience a sense of 
power over the subjects. Figure 4.50 shows an example of high angle shot.

Figure 4.50: An example of a high angle shot

Eye–level angle: It is a normal viewpoint, in which a camera is placed at the same 
level with an eye of the subject. It is a perspective that is most familiar to human 
beings because we usually see things at our own eye-level. It is advised to shoot 
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at the eye-level of the subjects, not yours. Figure 4.51 shows an example of a eye 
-level angle shot.

Figure 4.51: An example of eye level angle shot

Low Angle:  A low angle shot also called down shot, is when a camera is placed 
below the subject. The camera looks up on the subject that becomes important, 
powerful, and superior. Figure 4.52 shows an example of a low angle shot.

Figure 4.52: An example of a low angle shot

Bird Eye View: A camera is placed 90 degrees above the subject. It is over the 
head angle of shot and may be used to emphasize pattern and movement. It can 
also reveal isolation and congestion. The bird eye-view angle shots are to be taken 
by using helicopter, airplanes or drone cameras. Figure 4.53 shows an example of 
bird eye view angle shot.
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Figure 4.53: An example of a birds eye view angle shot

Camera Movements
A video camera should move to avoid a boring experience to the audience  
caused by a static camera. There are three types of camera movement, which are 
physical, mechanical, and mobile camera movements.

Physical camera movements 

Panning
Panning is a physical movement of a camera from left to right side of a frame 
and vice versa on a horizontal plane (see Figure 4.54). Panning enables a camera 
lens to scan the scene, providing the viewer with scene elements that would be 
difficult to capture in a wide-angle shot. By following a moving object, panning 
can show scene information as required. Panning should start and end smoothly. 
Neither a jerk at the start nor a sudden ending should be entertained. The tension 
and drag on a tripod head should be adjusted, to ensure smooth panning.

Figure 4.54: Camera panning movement 
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Tilting
Tilting is a physical movement of a camera up and down and vice versa on a 
vertical plane (see Figure 4.55). You can tilt the camera up to show the height of 
an object or subject. The relationships between objects in a scene can be shown 
by tilting the camera from one object to another. To add emotions to an event, tilt 
upward to create a sense of hope, expectation, or interest, and tilt downward to 
create a sense of sadness or disappointment.

Figure 4.55: Camera tilting movement

Mechanical camera movement 

Zoom In and Zoom Out 
A zoom camera movement is created by increasing or decreasing the angle of 
view. It is a change in the perspective of the subjects. A zoom movement allows 
you to show context and then push in to show detail. There are two types of Zoom 
movement: Zoom In is when you are tightening a shot and Zoom Out is the 
movement when you are loosening a shot.

Mobile Camera movements

Tracking
Tracking means moving a camera along with a moving subject or moving the 
camera parallel to the scene (Figure 4.56). Tracking is similar to what will happen 
if a camera was to move along with a person walking along a sidewalk. The 
person would seem stationary in the picture, but the background would appear to 
be moving. Tracking creates a feeling of observation or inspection.

Figure 4.56: Camera tracking movement
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Dolling
Dolling means moving a camera towards or away from a subject (see Figure 
4.57). The direction of a dolly draws different types of attention from the viewer. 
When a dolly moves towards the subject, the viewer’s interest is increased. In a 
horror movie, a camera dollied towards a sleeping young lady on a dark stormy 
night indicates that something is about to happen. Add a scary music, and you 
know something is about to happen. When a camera is dollied away, interest in 
the subject is lowered, and tensions are relaxed.

Figure 4.57: Camera dolling movement

Activity 4.5: Shooting a short video

Take a five-minute video using any available device and observe camera 
movement. Discuss your video recording experience with your friend.

Principles of video production 
It is easy to shoot a good video, if you follow the principles. To shoot a good video, 
you must abide to nine (9) video shooting principles.

Principle number one: You should not fire hose

Fire hosing means using a camera the way a fireman uses a fire hose on a fire. 
A running camera is panned from side to side or tilted up and down to record 
everything and anything. This results in a footage that is sickening to watch. 
It simply annoys a viewer. To avoid fire hosing, frame each shot, record long 
enough so that the viewer knows what is going on, stop recording, and then look 
for the next shot and record it. 
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Principle number two: You should have proper headroom

Improper headroom is one of the most common faults of videographers and 
photographers. Look at a few photos that you or a friend took. Chances are that 
many of them will have too much space above a subject. Remember that placing 
a person’s eyes one-third of the way down in the frame will provide proper 
headroom.

Principle number three: You should stay close to the subject

Stay close to the subject, and your images will not be shaky and small. Being too 
far away from a subject is another most common fault. The subject becomes small 
when the camera is far away. This places more of the scene in the frame than what 
is needed. The surrounding scene is not important. The subject should dominate 
the frame. Also, when a camera is too far away, the lens must be zoomed and can 
create a shaky video. Therefore, stay close to fill the frame with the subject and 
record some rock-solid video.

Principle number Four: You should not snap shoot

Snap shooting is recording shots for a very short time in such a way that it is 
difficult for the viewer to recognise what is happening. Unless you are producing 
a wild and crazy music video where short, fast-paced shots are normal, stay 
away from short shots. The viewer must be able to recognise what the shot is 
about. Additionally, if you are going to edit your production, you will need 3 to 4 
seconds of lead-time at the start of the shot and 3-4 tail time seconds at the end of 
the shot. This extra time is necessary for accurate and precise editing.

Principle number five: You should not headhunt

Headhunting refers to a situation in which a subject is always placed in the exact 
centre of the frame. Equal sides, top, and bottom surround a subject. It is as if 
a subject were in a gun sight. This is why it is called headhunting. The human 
eye cannot erase the often-large border that surrounds the subject. Headhunting 
creates a poor composition.

Principle number six: You should not over zoom

Over zooming occurs because people tend to be lazy. It is easier to zoom than 
to walk closer or away from a subject. Do not be a zoom monster. Zooming in 
and out is a poor technique. Plan your shots, especially if you are going to edit 
them. Shot sequences are better than zooms. However, news coverage and sports 
require zooming. It is appropriate in these situations. Zooming is also required to 
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develop a mood or feeling in a scene. Zooming in a slowly opening creaking door 
in a dark room surely sets a mood. Zooming out from a single person sitting on a 
chair in the middle of a large hall establishes a feeling. 

Principle number seven: You should take the camera off your shoulder

Take the camera off your shoulder and produce shot variety. Cameras were not 
meant to stay on your shoulder. They can and should be used at different positions. 
If an action is low to the floor, then the camera should be down there. If you are in 
a crowd where you cannot see the subject, then hold the camera over your head 
to get the shot. To see how camera positions and angles are used in broadcast 
TV, watch one minute of your favourite TV programme, and count the number 
of shots and different positions that were used. You will be amazed at how many 
they are. Remember, these shots were planned, and so should yours.

Principle number eight: You should not walk while shooting

Walking with a camera while recording is not good. Try to avoid it. If you must 
walk and handhold a camera, try the following techniques: set the camera to 
a wide range to eliminate some shakes; think that the camera is a hot cup of 
coffee that you do not want to spill; keep your arms and legs bent as you walk, to 
make them act as shock absorbers; move slower than normal; and do not hold the 
camera against any part of your body, to avoid shaking the camera.

Principle number nine: You should have good audio

Good audio is a must, because an audio carries the message, and a video supports 
it. When recording with a microphone built into a camera, use earphones to 
monitor the audio. Often, a microphone picks up too much sound, and most of it 
is unwanted noise that could overpower the important audio. When recording an 
interview using a built-in microphone, stay as close to the speaker as possible. 
This could eliminate unwanted noise. Ambient or natural sound, background 
music, and sound effects have different roles to play. However, be careful when 
using them. They could change an entire meaning of a message. 

    Exercise            4.4

1.	 Explain what an extreme long shot is. Give an example of how it may be 
used.

2.	 Why would someone choose to shoot a close-up when shooting 
a video? Give an example.
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3.	 Describe the Rule of Thirds and its importance in video shooting.
4.	 What is a leading room? Why would you use a leading room when shoot-

ing a shot?
5.	 Describe what will happen when you zoom-in with a video camera.
6.	 Why would you use zoom-in to establish a shot?
7.	 What does a medium shot allow an audience to see?
8.	 Explain the difference between a low angle shot and a high angle shot.
9.	 Give an example of an extreme close up shot and explain when and where 

it should be used.

Video editing

Concept of video editing
When you watch a video on a TV programme, you will notice that the performer 
appears in different locations with different outfits. What do you think was done 
to make it happen? When shooting a video, the shots may be taken from different 
places and in different modes. After a video shooting is completed, shots are mixed 
in a specific arrangement using special software. The process is referred to as 
video editing.

Video Editing is defined as the process of assembling and creating shots to make 
a TV programme, film, or video. The process of editing involves assembling of 
video material, selection of shots, ordering or arrangement of shots, and controlling 
the duration of shots. It is the process of selecting and arranging scenes so that 
the result satisfies the set objective. Generally, and in some instances, it is simply 
the process of selecting certain portions of an event or events and putting them 
into a meaningful sequence. A video editor is a person responsible for assembling 
the video material (recorded footages) and manipulating them to make a coherent 
whole.

Video editing procedure 
Logging: The first step is to preview and identify the video clips or tapes that 
contain the desired video and audio footages for editing. 

Import: The second step needs an editor to transfer and store the video source 
material to a computer and store it.

Editing: Third, using a specific software, the video editor engages in the process 
of editing. Some of the key activities include file identification, shot selection, 
sequencing, applying transition and effects, selecting sound portions, importing 
new sounds, mixing sound, synchronizing audio and pictures, etc.
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Rendering: is the process through which the computer changes transitions, 
special effects, and graphics from computer effects to video effects. This is an 
important procedure during editing of a video since it enables a smooth playback 
of all computer effects added on any video editing tool, streaming platform, or 
playback device. 

Exporting a video file: After rendering is done, the video editor is supposed 
to export a video file onto the desired format such as AVI, MOV, MPEG 4 etc., 
ready for sharing, playback or distribution. 

Using OpenShot software for video editing
As explained in the preceding section, video editing involves the selection and 
arrangement of useful information from various video clips. Consider a video 
shot from a five-hour wedding event; a final output of this video may become 
only two hours long after editing. This means that some events are selected, while 
others are discarded. In this book, OpenShot video editor will be used for video 
editing. The OpenShot video editing software is an open-source software, and is 
downloadable for free.

Step 1: Download OpenShot software

Download the OpenShot video editing software from http://www.openshot.org. 
Install the software by following the on-screen instructions. After installation, 
open the OpenShot video editor. Figure 4.58 shows the default interface of 
OpenShot video editing software.

Figure 4.58: OpenShot default interface
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You can change the theme (as shown in Figure 4.59) by following the path Edit 
tab-> Preferences –> Theme. This will enable you to select a new theme.

Figure 4.59: Changing a theme in Openshot

When you open OpenShot for the first time, there is a tutorial that describes the 
interface. Figure 4.60 shows the description of features on the main interface of 
OpenShot.

Figure 4.60: OpenShot editing features
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Step 2: Import a video footage

To edit a video, videos that you have shot must be imported from a video camera 
or any other source. To import a video, click the File tab and select Import Files 
(Figure 4.61).

Figure 4.61: Importing a video footage
The import file browser will be opened. Select all the footages you want to import. 
They will appear in the media browser (see Figure 4.62).

Figure 4.62: Imported video and audio files as seen in the media browser 

Step 3: Arrange the media

Arrange the video and audio clips on the tracks, following a timeline of the 
story you want to create (Figure 4.63).
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Figure 4.63: Timeline displaying the video tracks, media browser, and video preview window 

You can preview the video clips you have arranged in the media tracks, to see how 
they are related.

Step 4: Split (cut) and rearrange the video and audio accordingly. To split a 
media, place the cursor on the timeline point at which you want to split a  
video   (Figure 4.64).

Figure 4.64: Cursor placed on the video/audio split point
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Select the video or audio you want to split, right-click, and select Slice from the 
drop-down menu, as shown in Figure 4.65.

Figure 4.65: Slice sub-menu used to split the video or audio clip

The video/audio is cut into two pieces as in Figure 4.66.

Figure 4.66: Video cut into two pieces

You can move and arrange the video content, as shown in Figure 4.67. To move 
clips, click and drag the clip of interest to a position you want.
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Figure 4.67: Split and arranged clips
Step 5: Apply Transition

The term transition is not a new term to you as it was used when you learnt about 
the presentation program (MS PowerPoint). Similarly, video transition is a way 
you move a viewer from one video clip to another. When two video clips from 
different events are joined, the resulting video is not continuous. A transition is 
applied between the two clips to avoid a sudden jump from one video to the next.

Arrange the video clips you separated in Step 4 and insert another video clip 
between the two pieces. Arrange all of them on the same track (see Figure 4.68).

Figure 4.68: Rearranged video clips on one video track
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Transitions are of several types. In OpenShot, they are found on a window 
labelled transactions, similar to the one shown in Figure 4.69.

Figure 4.69: Video transitions in OpenShot

Drag and drop a Fade transition from the Transition window to a joint that links 
the first clip to the second clip (see Figure 4.70). Do the same on the second joint. 
In the transition’s properties, set the duration to two. Preview your video and see 
if you are happy with the results.

Figure 4.70: Inserting transitions between video clips

Step 6: Insert titles

In video editing, titles are texts that describe a video. These texts are inserted into 
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a video for different reasons. It can be to give a name to a video, to give a credit 
to the creators of a video, to provide a translation from one language to another, 
etc. To insert a title, select Title on the main menu. The title dialog box pops up 
(See Figure 4.71).

Figure 4.71: Video title dialog box

In the title dialog box, on Template, select Standard 1. On line 1, write 
Introduction video in the textbox provided; on line 2, write for our school in the 
textbox provided; on text colour, select Blue, and leave the default background 
colour. This will give your video a transparent background. The preview window 
will show the title as seen in Figure 4.72. Save the title with the name title1. It 
will appear on the project window. Insert title1 on the track above the video you 
have created.

Figure 4.72: Inserting a video title
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You can also change the duration time of appearance of the title by right clicking 
on insert titles and then choosing properties, as shown in Figure 4.73.

Figure 4.73: Changing the duration of a title

Step 7: Export your video

After editing your video composition, it is time to export it to a format that will 
enable a viewer to watch it. Viewers will not view your video on OpenShot. They 
will view it using their common players such as DVD players or through their 
smartphones. That is why you need to export it in common video formats. To 
export your video, click File-> Export. The export dialog will pop up, as shown 
in Figure 4.74.

Figure 4.74: Video export dialog box
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In the video export dialog box, write Video yangu on the File Name. In the 
Folder Path, browse to Desktop; in Profile select All Formats, on the Target, 
select MP4 (h.264); on Video Profile, select DVD/PAL; and on Quality, select 
Medium. Click the Export Video button located at the bottom of the dialog box 
to complete the export process.

Video compression
Video compression reduces and removes redundant video data so that a digital 
video file can use less storage space on a computer disk, or a video  can be 
easily sent over a network. Using efficient compression techniques, a significant 
reduction in file size can be achieved with little or no adverse effect on the visual 
quality.

Video codecs
A video codec is a software or hardware that can compress and decompress 
digital video. Compression involves applying an algorithm to a video to create a 
compressed file for transmission or storage. A compressed file can be played when 
an inverse algorithm is applied to produce a video that shows virtually the same 
content as an original video. The time it takes to compress, send, decompress, and 
display a file is called latency. The more advanced the compression algorithm, the 
higher the latency. Video Codec (encoder/decoder) are pairs of algorithms that 
work together to facilitate encoding and decoding of video files. Video codecs of 
different standards are usually not compatible. A video content that is compressed 
using one standard cannot be decompressed using a different standard. However, 
it is possible to implement different algorithms in the same software or hardware, 
enabling multiple compression and decompression techniques to work. Interframe 
prediction algorithms are used in video compressions such as MPEG-4 and H.264 
to reduce video data between a series of frames. This involves techniques such 
as difference coding, where one frame is compared with a reference frame, and 
only pixels that have changed with respect to the reference frame are coded. 
In this way, a number of pixel values that is coded and sent is reduced. When 
such an encoded sequence is displayed, the images appear as in an original video 
sequence.

There are two types of compression: lossy and lossless. Lossy compression 
means that the compressed file has less data than the original file. In some 
cases, this translates to lower quality files because the information has been lost. 
However, you can lose a relatively large amount of data before you start to notice 
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a difference. Lossy compression techniques produce comparatively small files. 
For example, DVDs are compressed using the MPEG-2 format, making files 15 
to 30 times smaller, but we still tend to perceive DVDs as having high-quality 
pictures.

Lossless compression is exactly what it sounds like: compression where none 
of the information is lost. Lossy compression is a one-way process (once you 
compress a file you cannot recover the original data). Lossless compression is a 
reversible process: you can always recover the original data. Normally, lossless 
compression is used to save a media file that is still being edited, while lossy 
compression is used to save a final version of a media file. For example, a Video 
Editor transferring files from one computer to another using a hard drive might 
choose to use lossless compression to preserve video quality while he/she is 
working. The commonly used codecs are MPEG, and H.264.

Video conversion
Video conversion is the process of changing video content from one video format 
to another. A normal video file in a digital format is made up of two parts: a codec, 
and a container. A container is a collection of files that stores information about 
a digital file. It simply means that there is a combination of both audio and video 
data in a single file to allow for simultaneous audio- with-video playback. Some 
popular types of containers are AVI (Audio Video Interleave), FLV (Flash Video 
Format), WMV (Windows Media Video), MOV (Apple QuickTime Movie), and 
MPEG-4 (MP4) (Moving Picture Experts Group 4). Video conversion is usually 
done by using video converters. Video converters are computer programs that can 
change the storage format of a digital video. They may recompress the video to 
another format in a process called transcoding. The disadvantages of transcoding 
are that there is quality loss when transcoding between lossy compression formats 
and that the process requires high computer power.

Project work

Form a group and prepare a ten-minutes video about one of the following: 
your school, village, street, city, or any other interesting event of your life.
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Exercise 4.5

A.	 True/False questions

1.	 Newspaper is the first communication medium to use 
multimedia when communicating information _____

2.	 A television programme is an example of non-linear multimedia  
_____

3.	 When shooting a video, a medium shot helps viewers to see 
more object details _____ 

4.	 A television is the popular multimedia communication media  
_____

B. 	 Short answer questions 

1.	 What is multimedia?

2.	 Briefly explain any four applications of multimedia.

3.	 Explain why multimedia is essential in the world today.

4.	 Describe the use of a microphone in a multimedia presentation.

5.	 Describe two types of multimedia content and give an example of 
each.

6.	 Use appropriate examples to describe the types of digital audio 
formats.

7.	 What is aspect ratio in video recording? Describe two commonly 
used values of aspect ratio. 

8.	 What is video editing?

9.	 Mention any two broadcast video standards and compare their 
specifications and applications.

Revision questions
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10.	 Describe panning and its importance.

11.	 Mention four different sounds editing software and, with reason 
state the one best suit in your environment.

12.	 What is the importance of software in multimedia?

13.	 Describe video compression and its importance?

14.	 Describe two types of compression as used in the video editing 
world. In what situation can each be used?
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The concept of interactive content
Interactive content is content that allows direct interaction between the user 
and the content. It requires active engagement from its users or consumers. It 
empowers users to be more active by being an integral part of a dynamic two-way 
experience between the user and the content. It necessitates a user to take actions 
like typing, clicking, or actively engaging with a scene or an event. Possible 
user actions include rotating and zooming in an interactive multimedia content, 
answering questions by clicking on specific parts of the content or typing some 
text, choosing items in a list, and responding  to a message via recorded voices. 
Examples of interactive content include interactive infographics, interactive 
videos, and interactive e-books; and electronic assessments, mail, polls, surveys, 
and quizzes. Figure 5.1 shows examples of interactive content. 

Chapter

Interactive content

05

Introduction
In the past, people watched cinema that was projected to a screen and 
controlled by a single person. They also listened to radio and watched 
television, with no option to stop a scene or control the speed of delivery. 
Thus, content delivered through radio and television programmes were not 
interactive, because users were unable to interact with it. Today, some TV 
and radio programmes can be delivered in an interactive way. Customers 
can control what they want to watch or listen to. This is also true for other 
content that allow user interaction. In education, for example, there are 
software that enable learners to access a lot of learning materials interactively. 
In this chapter, you will learn about the concept, development, and use of 
interactive content. The competencies developed will enable you to create 
and use interactive content.  
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Figure 5.1: Examples of interactive content

Importance of interactive content
Interactive content has several benefits including the following.

Increases awareness and attention of users: Since the content requires active 
participation of the user, it increases awareness and attentiveness. 

Greater social engagement: The content allows more than one individual to 
interact with it in the form of competition, and hence promoting social interaction 
among them. Likewise, users can use more than one sensory organ, increasing 
their activeness.  

Increases exposure: Because the interaction with content involves more than 
one sensory organ and hands-on activity, a user becomes familiar with the content 
very easily, and cannot forget the content easily.

Reduce risks: Interactive content can be used in simulation, particularly in 
learning, instead of real practicals which involve high risks such as experiment 
with harmful chemicals. In such a case, simulation reduces the risk of accident 
in practical work.  

Characteristics of interactive content
The following are some characteristics of interactive content.

User-controlled and adaptable: Interactive content allows learners/users to 
control the pace of navigation, for example, speed of audio, video or running 
simulations.	
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Promote active engagement: Interactive content allows active engagement, 
for example, a self-instructional mode of learning, whereby a learner performs 
specific actions required for learning. Leaners can provide active responses to 
puzzles, questions, and answers.

It has a specific target: Interactive content is usually designed for a particular 
target group. Examples of interactive content that target specific groups are 
keyboard-controlled games, keyboard typing skills programs for beginners, 
interactive drawing activities for children, children speaking drills, children 
writing drills, student electronic assessment, and interactive numeracy courses 
for children. 

Comprehensive: In teaching and learning, for example, Interactive content often 
stick to concepts or skills required for learners to gain the intended competences. 
Sometimes the program scene does not allow users to continue to a next stage 
before mastering the prerequisites. 

Immediate feedback: In teaching and learning, for example, Interactive content 
can provide immediate feedback to learners, giving them insight that can enable 
them to learn more. An example of immediate feedback is found in interactive 
electronic assessments.  

Accessing and using interactive content 
An essential feature of interactive content is that it should actively engage a user 
rather than making them watch it passively. In this section, you will practice 
using some interactive content from Physics Education Technology (PhET) 
Simulations developed by the University of Colorado. 

PhET Simulations is an  interactive content website founded in 2002 by Nobel 
Laureate Carl Wineman. The site is owned by the University of Colorado (USA). 
Originally, the site was designed to contain interactive content to facilitate 
the teaching and learning of Physics subject, hence its name PhET. Further 
research has enabled the development of the site to include interactive content 
for mathematics and other science subjects (Chemistry, Biology, and Earth 
Sciences).   Activity 5.1 guides you to access and use interactive content from 
PhET simulations.

Activity 5.1: Accessing and using interactive content from PhET simulations 

(i)	 Open a web browser, e.g., Google Chrome or Mozira Firefox.

(ii)	 Open  the URL phet.colorado.edu. An interface similar to the one in 
Figure 5.2 will be displayed. 
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Figure 5.2: PhET simulations interface 

(iii)	 Using the Simulations tab, choose a subject, or click on the icon with the 
name of the subject you want, e.g., Physics. Different topics will appear, 
as shown in Figure 5.3.

Figure 5.3: PhET Interactive Simulations for physics 

(iv)	 Choose the content under the Motion category: all the available interactive 
content about motion will be displayed as shown in Figure 5.4. 
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Figure 5.4: Simulations for Motion in Physics 

(v)	 Click on the Balancing Act simulation: an interface similar to the one 
shown in Figure 5.5 will appear. 

Figure 5.5: Interface for playing balanced motions 

(vi)	 Click the Play button (icon): the interface for the balancing act will appear, 
as shown in Figure 5.6. 
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Figure 5.6: Interface for balancing act

(vii)	 Click the Balance Lab option: the interface for balancing lab will appear 
as shown in Figure 5.7. 

Figure 5.7: Interface for balancing lab

(viii)	 Click the Change Pivot button: the interface for load balancing will appear 
as shown in Figure 5.8. 
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Figure 5.8: Interface for load balancing

(ix)	 Play Balancing Act using different weights on two sides as shown in 
Figure 5.9. 

NOTE: �To start interacting with the Balancing Act, slide the button labelled A 
to the right (Change Pivot button) in the interface labelled 1, resulting 
in an interface labelled 2.  Choose a load of a certain mass (see the 
interface labelled 2), drag and drop it on one side (on the left side, in 
this example) of the lever. The lever will tilt towards one side (see the 
interface labelled 3). Pick a load of similar mass and drag and drop it on 
another side (the right side) at a distance equal to that of a load on the 
left-hand side from the pivot (see an interface labelled 4). The lever will 
balance because loads of equal mass are placed on both sides, at an equal 
distance from the pivot.  Click at an arrow pointing to More Masses in 
the interface labelled 4 to get more masses and try more interactions with 
the Balancing Act.
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Figure 5.9: The Balancing Act PhET simulation

Exercise 	 5.1
By referring to the steps outlined in Activity 5.1, play the following simulations: 

1.	 Three more Physics simulations 

2.	 Four Chemistry simulations

3.	 Six Biology simulations

4.	 Three Earth Science simulations

5.	 Five Mathematics simulations

Preparing interactive assessments 
Assessment uses different tools such as tests, quizzes, and examinations. In 
traditional classrooms, paper and pen are used when responding to assessment 
questions. This mode of assessment requires face to face administration of 
assessments. Teachers perform a series of activities such as test composition, 
preparation of a marking scheme, test administration, marking of test, and 
processing of results. This process is tiresome and time-consuming. In this part, 
you will be oriented on various tasks in interactive assessment.

In interactive assessment, the preparation, administration, and marking of 
responses to assessment questions is done using content installed on computers, 
tablets, and smartphones, or online. Through interactive assessments, students 
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can get instant feedback about their scores and correct responses to the questions 
asked. There are numerous online tools that can help you compose and administer 
online assessments. Such tools include Google Forms, Survey Monkey, and 
Moodle. Activity 5.2 guides you on creating interactive assessments using 
Google Forms.

Activity 5.2: Creating interactive assessment 

(i)	 Using your username and password for Gmail, Sign in to your Google 
Account, 

(ii)	  �Clicking on Google Apps: several apps will appear as shown in Figure 
5.10. You will then be able to scroll down to Forms. 

Figure 5.10: Opening Google Forms from a Gmail account

(iii)	 Click on Forms: a window like the one shown in Figure 5.11 will be 
displayed. 
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Figure 5.11: Options for creating a new Google form

(iv)	 Click on Blank: a window labelled Untitled form will appear, as shown 
in Figure 5.12. 

Figure 5.12: Options available on a Google forms

Key: 

1 = Add a question			   2 = Import questions 	

3 = Add a title and a description 	 4 = Add an image	

5 = Add a video 			   6 = Add a section 

(v)	 Click on Settings, and then choose Make this a quiz,
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NOTE: There are various settings that can automatically be applied once 
you choose Make this a quiz. You can change them based on your 
preference. For example, you can choose how you want to release the 
grades, whether it should be immediately after submission or later after 
a review.  

(vi)	 Click on Questions and change the title to ICS Test for Form Four 
Students,  

(vii)	 Write test instructions on the description area, 

(viii)	 Add a section to your test by clicking the Add section button (number 6 
in Figure 5.12), 

(ix)	 Name the added section as “Student’s Particulars”, (see Figure 5.13), and 
provide spaces for student’s name and school name. 

Figure 5.13: A section for student’s particulars 

(x)	 Click the Add question button, and start typing your multiple-choice 
questions, as shown in Figure 5.14, 

(xi)	 Click on Option 1 to add the first distractor, 

(xii)	 Click Add option to add the second distractor and do so until all distractors 
and a correct answer have been added, 
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Figure 5.14: Adding questions and response options to a Google Form

(xiii)	 Click on Answer key to set the correct answer, as shown in Figure 5.15

Figure 5.15: Selecting a correct answer and assigning it a score value

(xiv)	 Select the correct answer, 
(xv)	 Set a score value for the answer, 
(xvi)	 Click on Done and you will be taken back to the questions window, 
(xvii)	 Click Add new question to add another question. 

NOTE: �If you want a student to answer each question in a Google form, you 
must activate the Required button provided on each question.
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Previewing a quiz 
Once all questions are on the form, you can preview the quiz to see how questions 
will appear. The procedure in Activity 5.3 guides you to preview a quiz. 

Activity 5.3: Previewing a quiz

(i)	 Click the preview icon as shown in Figure 5.16: a new page that enables 
you to preview your quiz will appear. 

Figure 5.16: Quiz page preview

(ii)	 Click on the Send button to send your quiz to the intended audience, e.g., 
students, 

(iii)	 After sending a quiz to students, click the Responses button to see the 
results. 

Exercise 	 5.2
Use the procedure in Activity 5.2 to create an online quiz that consists of the 
following multiple-choice questions.  

1.	 One of the following is a software used to prepare and make presentations.
(a)	 MS Word
(b)	 MS Excel 
(c)	 MS Publisher 
(d)	 MS PowerPoint 

2.	 In MS PowerPoint a view used when making a presentation is known as
(a)	 Normal view
(b)	 Slide Show view
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(c)	 Outline view
(d)	 Slide Sorter view

3.	 One of the following is a feature of interactive content.
(a)	 Actively engages a learner
(b)	 A recorded video clip 
(c)	 Electronic in nature
(d)	 Multimedia in nature 

4.	 The following is a mass media that does not incorporate multimedia:
(a)	 Newspaper 
(b)	 Television 
(c)	 Radio 
(d)	 Internet 

5.	 MS Publisher is an application software used to
(a)	 Make presentations 
(b)	 Prepare publications such as business cards 
(c)	 Perform arithmetic operations 
(d)	 Prepare documents such as letters

Administering an interactive assessment 
Administration of an interactive assessment is a process of making an assessment 
task (such as a test) available to those who are being assessed. Unlike traditional 
assessment tasks, which are typed on papers and administered in classrooms or 
halls, interactive assessments are administered and done using ICT devices such 
as computers, tablets, and smartphones. In this section, you will use the forms 
created in Exercise 5.2 to practice how to administer an interactive assessment. 
Activity 5.4 guides you to administer your assessment to users. 

Activity 5.4: Administering an assessment to users 

(i)	 Open the form for ICS Test for Form Four Students form you created in 
Activity 5.2,

(ii)	 Click Send: Send form sub-window will appear as shown in Figure 5.17, 
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Figure 5.17: Send form window

Key: 

1 = E-mail			   2 = Link 		  3 = Embed HTML

4 = Facebook 			   5 = Twitter 

NOTE: �You can share your form either by a link,  e-mail or social media such as 
Facebook and Twitter. In this case, use a link to share your form.

(iii)	 Click the Link icon: a link will appear as shown in Figure 5.18,

(iv)	 Check Shorten URL to make the link shorter,

(v)	 Click Copy to copy the link, 

(vi)	 Share the link with respondents through e-mail or social media. 

Figure 5.18: Sharing a Google Form 
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NOTE: �When sharing a form via e-mail, write email addresses of students on 
the IO field and check the box for Include form in email. You can also 
include a message to introduce a quiz to students. Clicking the Send 
button will share a quiz via email.  

Responding to an interactive assessment 
Unlike paper and pen tests in which one is  provided with papers containing 
questions, tests prepared using Google Forms are administered using a clickable 
link. To have access to the questions, a learner must click the link to open the 
form and attempt the questions. Where applicable, a student must click the Next 
button to proceed to a next section of a test. Activity 5.5 guides you to respond to 
interactive assessments.  

Activity 5.5: Responding to interactive assessments  

(i)	 Click a link sent to you through e-mail or social media,

(ii)	 Write personal information in appropriate fields,

(iii)	 Attempt the questions in the form, 

(iv)	 Click the Submit button to send your responses.

Previewing assessment results
One of the main features of an interactive assessment is that the results can be 
generated automatically. Thus, you can preview the assessment results as soon as 
a user submits the responses. The procedure in Activity 5.6 guides you to preview 
the results of an interactive assessment.

Activity 5.6: Previewing the results of an interactive assessment

(i)	 Open the Google forms,

(ii)	 Click on the Responses button (see Figure 5.16) to identify the number 
of respondents to your assessment tool: the form will display the number 
of respondents as shown in Figure 5.19,

(iii)	 Slide the Accepting responses button to the left to stop receiving more 
responses, 
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Figure 5.19: Responses window 

(iv)	 Click the Summary tab which is selected by default, to see a summary 
of responses,

(v)	 Scroll down to see different aspects of the summary,

(vi)	 Click the View responses in the Sheets icon,  

(vii)	 Click on Create to tabulate the results for each respondent (in case the 
tabulation did not appear automatically). Figure 5.20 shows an example 
of a responses table generated through Google form. 

Figure 5.20: A table preview of interactive assessment results
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Exercise	 5.3 

Use Google Forms to compose an interactive test of any subject for your 
choice. The test should contain multiple choice and True/False questions. 
Administer the test to your fellow students and preview the results. 

Using a software to create simple animation clips 
There are various software you can use to create animation clips. Examples of 
such software are Windows 10 Video Editor, EzVid, VideoLAN, OpenShot, and 
Wax. This chapter introduces you to the use of Windows 10 Video Editor in 
creating a simple animation clip. But before creating simple animated clips, you 
will have to explore the Windows 10 Video Editor to orient yourself about its 
features. 

Exploring the Windows 10 Video Editor
The Windows 10 Video Editor contains different parts such as preview, timeline, 
and storyboard, as shown in Figure 5. 21. 

Figure 5. 21: Parts of the Windows 10 Video Editor

Preview: Preview allows you to preview the video you are working on. It also 
includes three control buttons: play, move forward, and move backward.

Storyboard: The storyboard allows you to import and arrange images in a 
sequence. You can also prepare your detailed storyboard in a hand-drawn draft. 
The storyboard may act as a plan that contains images and instructions to create 
a video. It allows you to have a clear overview of how the whole video will 
look like. It gives you instructions on how to create or design a video. Sample 
templates of a storyboard are available online. The procedure in Activity 5.7 
guides you to create a simple storyboard.
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Activity 5.7: Creating a simple hand-drawn storyboard

(i)	 Choose a title, e.g., Leopard hunter,

(ii)	 Choose a storyboard template available online. For example, you can use 
a template similar to the one shown in Figure 5.22. 

Figure 5.22: An example of a storyboard template

(iii)	 Fill the template with your story, providing photos and descriptions as 
shown in Figure 5.23. 
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Figure 5.23: An example of a filled-in storyboard template

Using Windows 10 Video editor to create movie clip 
The procedure in Activity 5.8 will guide you to create a simple movie clip using 
Windows 10 Video Editor.

Activity 5.8: Creating a movie clip using Windows 10 Video Editor

(i)	 Download two different leopard photos from the Internet and save them 
on your computer,

(ii)	 Open Video Editor by writing ‘Video editor’ in the search area (see Figure 
5.24). A window resembling Figure 5.25 will be displayed.
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Figure 5.24: Opening a Video Editor through the windows search area 
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Figure 5.25: Interface for Windows 10 Video Editor 

(iii)	 Click on New video project. A window similar to the one shown in Figure 
5.26 will appear.	

Figure 5.26: A dialog box for naming a new video project
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NOTE: �Review the storyboard to see what you planned to include in the clip, 
i.e., from the title to photos and audios.

(iv)	 Type Leopard Hunter as the title for the video clip. The window shown 
in Figure 5.27 will appear.

Figure 5.27: A window with a video title 

(v)	 On the Project library area, click on Add to insert pictures from your 
computer into a video project.

(vi)	 Drag the pictures to the storyboard of the Windows 10 Video Editor: the 
pictures will appear as in Figure 5.28. 
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Figure 5.28: Pictures added to the storyboard 

(vii)	 Insert a text over the picture by clicking on add text button as shown in 
Figure 5.29. 

Figure 5.29: Using a storyboard to insert text over a picture
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The text will appear as shown in Figure 5.30. 

Figure 5.30: Text inserted on a picture

(viii)	 Insert audio as specified in your storyboard (refer to figure 5.23).

Challenges of interactive content 
Despite the advantages of interactive content for learners, the following are some 
challenges of interactive content. 

1.	 It can be challenging to take care of the requirements for inclusive learning. 

2.	 Computer skills are required to design and use interactive content. 

3.	 Designing, administering, and using interactive content can be costly.

4.	 It is difficult to control the behaviours of learners as they learn in isolation. 

5.	 The need for appropriate ICT infrastructure (such as network and computer 
devices) makes it difficult to perform a comprehensive assessment that 
covers all materials.
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Project work 

1.	 Choose one subject among the following: ICS, Biology, Physics or 
Chemistry; use a Google form to create a quiz that consist of twenty 
multiple choice questions, ten True or False questions, and ten matching 
item questions.  

2.	 Create a hand-drawn Storyboady about your favourite national park in 
Tanzania and create a corresponding animated clipboard using Window 10 
Video Editor. 

Exercise 5.4 
Review questions 

Section A: True/false 
Write T for a true statement and F for a false statement 

1.	 A computer typing game is an example of interactive content_____

2.	 Interactive content makes users passive consumers of knowledge ____

3.	 PhET simulations contain interactive content for all subjects ____

4.	 All simulations in PhET can be played through similar procedures ____

5.	 Students can attempt interactive assessments through smartphones____

6.	 Interactive assessments prepared by Google Forms can be administered 
using emails and WhatsApp____

7.	 The Responses tab in Google Forms helps to identify the number of users 
who have attempted the questions____

8.	 You can use Windows 10 Video Editor to create animated clips ____

9.	 Interactive content cannot be used in face-to-face teaching and learning 
contexts ___

Section B: Matching items
Match an item in List A to a corresponding item in List B by writing the letter of 
the correct response beside the item in List A. 
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List A List B
1.	 Google form ____

2.	 Storyboard ____

3.	 Ezvid ____

4.	 Google Sheets 
____

5.	 Windows 10 Video 
Editor ____

a.	 Used to create animated video clips

b.	 Open-source software used to create animated 
video clips

c.	 Can be used to organise data collected through 
Google Forms 

d.	 A plan that contains images and instructions to 
create a video clip

e.	 Designs graphics for interactive content

f.	 Used to create interactive assessments

g.	 Used for marking interactive assessments

Section C: Multiple choice
Choose the most correct item among the given alternatives and write its letter 
beside the question number.  

1.	 One of the following is not an example of interactive content.
(a)	 Typing Game
(b)	 A solar system simulator
(c)	 A recorded instructional video
(d)	 A Balancing Act Simulator 

2.	 One of the following is an important feature of interactive content 
(a)	 Engagement 
(b)	 Inclusiveness 
(c)	 Representativeness 
(d)	 Responsiveness 

3.	 An interactive content that learners can use to perform experiments online 
is known as:
(a)	 Simulation
(b)	 Virtual Lab
(c)	 Game
(d)	 PhET Simulations 
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4.	 The following are needed to access PhET simulations except:
(a)	 Computers
(b)	 Internet services 
(c)	 Gmail Account 
(d)	 Internet Browser 

5.	 The following are the advantages of interactive assessments except:
(a)	 Easy to mark the question papers

(b)	 Easy to get assessment results

(c)	 Easy to administer

(d)	 Easy to keep assessment records 

Section D: Short answer questions 
Answer the following questions 

1.	 Describe features that make learning content to be regarded as interactive.

2.	 Does interactive content respond back to users? If your answer is yes, how? 
If your answer is no, why? 

3.	 Do you think it is good to learn through interactive content? Provide a 
reason for your answer.  

4.	 Describe the difference between animation and video clips.
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Glossary
Algorithm	 A step by step procedure followed to solve a problem, 

especially by computers 	

Amplitude	 The measure of height of a sound wave, or the 
maximum displacement of a sound wave  

Animation 	 A technique of making pictures, texts, shapes, and 
other objects to appear to be moving 

Audience	 A group of listeners or viewers at an event such as a 
meeting, a concert, and a play or film  	

Audio	 Anything related to sound in terms of receiving, 
transmitting or reproducing  frequency

Dolling	 A technique of moving a camera while shooting a 
video. It involves moving a camera towards or away 
from a subject  	

E-book 	 Is a book available in digital form, and readable 
through ICT gadgets such as computers, tablets, and 
smartphones 	

Electronic Polls 	 A system of casting and counting votes through 
electronic means

Electronic presentation 	 A presentation that involves the use of special 
computer programs to prepare and deliver it, using 
devices such as computers and projectors

Facial expressions 	 A body language or non-verbal language which 
expresses one’s inner state such as happiness, sadness, 
anger, surprise, fear, and disgust 

Flipchart 	 A presentation aid consisting of a collection of large 
paper sheets that a presenter can use to write some 
key points during a presentation 

Framing 	 Placing or positioning of subjects in a shot during 
video shooting 

Frequency 	 Refers to the number of times an event is repeated per 
unit time
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Handouts	 Printed materials given to the audience during a 
presentation, to enable them to follow a presentation

Hyperlink 	 A word, phrase, or image that, when clicked, directs 
you to another object such as a video clip, audio, 
image, text, or a document 

Hypermedia	 A system in multimedia technologies that enables 
materials such as images, pictures, audio, and texts to 
be opened by clicking the links in a web browser 

Infographics	 A visual representation of images such as charts, 
graphics, and text that enables easy understanding of 
a topic

Interactive Assessments	 Assessment tools prepared, administered and marked 
using ICT tools such as computers, tablets, and 
smartphones 

Interactive Content	 Content which makes users to actively engage with it 
through performing some-on-screen actions such as 
clicking and dragging rather than passively following 
a content

Layout	 The arrangement of items on a document to suite 
different themes such as comparison, differences, and 
title with content

Master slide	 A parent slide in MS PowerPoint, from which other 
slides in a presentation draw common features 
such as header, footer, slide number and name of a 
presenter	

Microphone 	 A device that transform sound energy to electronic 
signals when recording or speaking 

Multimedia	 The way of conveying information using more than 
one medium 

Multimedia content 	 Content that combines various media such as audio, 
video, text, animation, and graphics to present 
information
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Multimedia Projector 	 A device that receives multimedia content and displays 
it on a big screen for the audience to see clearly	

Panning	 A physical movement of a camera from left to right 
and vice versa on a holizontal plane during video 
shooting

Pitch	 The measure of how high or low a sound is

Podium 	 A small platform where a presenter stands by to 
deliver a presentation 				  

Presentation software	 Computer program used to prepare and deliver a 
presentation. Examples of presentation software are 
MS PowerPoint and Google Slides

Presenter	 A person who delivers a presentation to an audience 

Quiz	 An assessment tool that enables users to attempt the 
questions about a certain theme

Scene	 Video clips recorded using a camera, and can be 
joined to get a complete video about an event 

Sequence	 A collection of scenes that have been joined and 
arranged to get a complete and coherent video about 
an event 

Slide Show	 Viewing the slides of a presentation in full screen 
mode 

Slides	 A frame like a page that is used to hold the content of 
a presentation

Sound	 Vibrations that travel through the air or another 
medium and can be heard when they reach an ear of a 
person or an animal 	

Templates 	 Pre-prepared pages in a computer program which can 
be used as they are or can be customised to suit one’s 
needs 

Tilting	 A physical movement of a camera up and down and 
vice versa on a vertical plane  
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Tracking	 The process of moving a camera along with a moving 
subject, or moving parallel to a scene, during video 
shooting 

Transition	 These are illusions that occur when you move from 
one slide to another in a presentation software or from 
one shot to another in an edited video		

Video 	 A group of moving visual images recorded using a 
video camera 

Video Compression	 The process of reducing the size or number of bits of 
a video  

Video Conversion	 The process of converting a video from one format to 
another 

Video Editing 	 The process of manipulating video shots, scenes, and 
sequences to produce a desired video of an event

Wavelength	 The distance between similar points on a wave

Whiteboard 	 A reusable board with a white surface that is used for 
writing purpose during a presentation. The board can 
be reused after wiping its content

Zoom in 	 A mechanical movement of a camera lens that helps 
to tighten a shot. It is an action of adjusting a camera 
lens so that the subject seems to be larger 

Zoom Out 	 A mechanical movement of a camera lens that helps 
to loosen a shot. It is an action of adjusting a camera 
lens so that the subject seems to be smaller and farther 
away 
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